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Introduction
Welcome to theGibbsCAMCommonReference guide. GibbsCAM is amodular application,
meaning that different customerswill have different functions depending on their need. In other
words, not everybody needsMill/Turn functionality or the SolidSurfacer module.

But much of GibbsCAMs interface and functionality is shared or is common across themany
modules. This guide documentsmost of the common interface items found throughout GibbsCAM.
Some options or third-party packages create their ownMenu Bar entry. These packages are not
covered in this guide. Intermediate Tooling, Reporter, and Plug-Ins are all covered in separate
guides.

It is recommended that you also read theGetting Started guide in conjunction with this guide.
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Main Screen Components

1. Quick Launch Bar 4. Status Bar 7. Process List 10. Operations List

2. MainMenu 5. Commands
toolbar 8. Axis Block 11. Trash

3. Floating Toolbar 6. Tool List 9. Workspace 12. Command Search
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Main Menu
TheMainMenu is available to the user at all times. TheMenu provides access tomany of the
system’s functions through individual sub-menus. Some itemsmay or may not appear depending
on the installed options.

1. Quick Access Toolbar
This can be customized and extended if
required. See Customizing the UI.htm

2. File Menu
3. The Edit Menu
4. The View Menu
5. TheModifyMenu
6. The SolidsMenu
7. The FeaturesMenu

8. TheWindow Menu
9. The Plug-InsMenu
10.TheMacrosMenu
11.TheWire EDMMenu
12.The HelpMenu
13.Current filename display
14.Command search.

Command Search

Command Search lets you find a command just by typing in a portion of its name.

You can hover your cursor over a list entry to see tooltips
(illustrated left). Click to execute the command. Click either the

main or sub-menu icon to highlight the command in the
UI, (it flashes yellow) but not execute it.

If a menu item is grayed out, it cannot be selected. Selecting geometry or some other appropriate
item on the screenmay change themenu item so that it becomes black and can be selected.
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File Menu

The systemwill keep track of the parts that have beenmost recently used and will display
information on folders. Moving the cursor over a recently opened file displays a larger preview of the
part.

Clicking the pin icon on the part view saves the part file onto the pinboard. This is a scrollable
expanding area which enables parts to be grouped together and will allow more than themost
recent parts to be saved. Use the large pin icon at the top of the pinboard to hide/unhide the pins. All
the last opened part information and pinboard is saved for your next session when you exit
GibbsCAM.

In addition to the standardWindows file controls, there are additional options as detailed below:

File Items

Open
Displays theOpen dialog. Change to the filetype required, or choose All Files (*.*). Browse to the file
you want to open and clickOpen. If a file is currently open, it is closed and the file you select opens.

Save a Copy
This will save the current file under a different name or version and let you continue working with the
original file — the original file will remain open.

Previous system versions are available to save the type to an older version. Please note that saving
a file to an older versionmay cause the part to lose capabilities or functions not available in the older
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version. In particular, for parts with toolpath created using Advanced 3D, 5-Axis, VoluMill, or
VoluTurn, we recommend against saving parts backwards to GibbsCAM12 or earlier.

Type Default Part

You can designate that a particular part file is the default part associated either with one of two
machining types (Mill or Turning) or with anMDD (Machine Definition Document):

l To save the part as the default for its type, choose File > Type Default Part.

l To save the part as the default for itsMDD, choose File > MDD Default Part.

Result: The part is saved in a special folder (the Default Parts Folder) with a special filename, such
as (for Type Default Part) New Mill Part.vnc, or (forMDDDefault Part) New 3 Axis Vertical
Mill.vnc. The name and location of the Default Parts Folder are available through Pathfinder —
typically
C:\Users\<username>\AppData\Roaming\CAMBRIO\GibbsCAM\<version>\DefaultParts\.
When a new part is created, theMDD Default Part will be copied in if it exists for thisMDD;
otherwise, the Type Default Part will be copied in; or, if there is no default part set for either the
MDD or themachining type, then the new part will be blank.

Definition:
In GibbsCAM terminology, theMDD (Machine Definition Document) is where all aspects of a
particular machine are organized and stored, including its linear and rotary axes, its toolgroups,
spindles (part stations), and utility stations, and how these are associated and organized into Flow
Axis Sets, InteropMoves, etc. It also specifies the post processors, coolants, extended cycles, and
simulation bodies available to themachine, and it records preferences for work areas, limits,
clearances, andmany other items.

Exchange

Import/Export

The Import and Export dialogs allow a variety of file types to be exchanged into and from the current

file. Each of the import types can be directly opened through the File > Open command. For
specific information on how each file will be interpreted and translated, see the Data Exchange
guide.

Pack and Go

You can easily create and use package files (*.gcpkg) containing aGibbsCAMpart and the
transportable portion of the environment that the part requires or expects.

Please Note: Be aware of proprietary considerations before you share parts and
environments with others. For example, youmight have a part file that is not proprietary, but
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its associated post, or Machine Sim part files, might be subject to a license or nondisclosure
agreement.

To create a package: On themainmenu, File > Pack and Go.

The following are all included in the package:

l part file (always)
l MDD (always)
l VMM (always, if present)
l Templates for Basic Utility Operations (always, if present)
l Machine Simulation files (optionally, if present)
l Intermediate Tooling files (optionally, if present)
l Postprocessor file (optionally, if present)
l Macros for custom drill cycles (always, if present)
l system diagnostic file

To use a package: Simply drag the *.gcpkg file into GibbsCAM. A temporary "sandbox"
environment will be created that will be automatically deleted when you close the part.

Peripherals

Print Drawing

Selecting Drawing... (Ctrl+P) will print the geometry, toolpath, and the rendered image as they
currently appear on the screen. The exact output will vary depending on the settings in the Printing
preferences; see “Printing ” on page 24.

Post

Post... becomes active when a file has been post processed. Posted output can also be printed from
the Post Processor dialog.

Communication

Communication dialog allows the user to specify how to send and receive text or VNC files to and
from themachine control. The Communication dialog can also be accessed from the Post
Processing dialog. For more information on the use of this dialog and Post Processing see the
Getting Started guide and the guides for Mill or Turning.

Intermediate Tooling

UKMprovides the ability to support a Toolblock Library (a generic term encompassing adapter
blocks, holders for toolholders, right-angle heads and adjustable heads, etc.) and a
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Fixture Library (chucks, tailstocks, steadyrests, etc.). For a part setup, you can see locations
and orientations of toolblocks and adjust their offsets, and you can control the display of tools and
toolblocks in the toolgroup. For more information, see “ Intermediate Tooling Preferences ” on

page 48. You can also change themachine configuration using Machine Data.

Application

Preferences

Preferences opens a dialog that allows you to set all the preferences and behaviors for GibbsCAM.
This includes communicationswith a CNC, establishing default file extensions, and details on how
to save files and set up the display output, as well as interaction with themouse or digitizer. All the
preference settings are described in “ Preferences” on page 14.

Materials

This choice opens theMaterials dialog which allows you to view, add andmodifymaterial properties
and cutting speeds. For a full description of this function, see “ Materials” on page 51.

Exit

This closesGibbsCAM.

Preferences
The Preferences dialog presents tabs containing controls that affect different parts of the system.

1. Display Preferences , next

2. “Interface Preferences ” on page 29

3. “           Machining Preferences ” on page 35

4. “            File Preferences” on page 39

5. “            Import/Export Preferences” on page 41

6. “            Auto Save Preferences ” on page 42

7. Coordinate SystemsPreferences

8. “           Post Processor Comments ” on page 44

9. “             Communication Setup Preferences” on page 47

10. “ Intermediate Tooling Preferences ” on page 48

11. “            G-Code Editor Settings ” on page 49

12. “            Additive Preferences ” on page 51
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Display Preferences

TheDisplay preferences affect what you see on screen or what you print out.

Cut Part Rendering

The Cut Part Rendering section specifies preferences for the display when a part is being virtually
machined, including how tools are displayed.
Auto Tool Size
Thismodifies the length of some tools to maximize the visibility of Cut Part Rendering. Very long
tools are shortened and short tools are lengthened to just above the stock to ensure visibility. Thus,
a short tool will not be hidden inside a pocket when being rendered.When Auto Tool Size is disabled
the systemwill display tools as they actually look. This is particularly useful for Turning threading
and grooving operations and somemilling operations. Activate Auto Tool Size if you have an older
computer or are not concerned with tool length, as this will increase Cut Part Rendering speed.
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1.Enabled
2.Disabled

Auto Tool Size enabled and disabled examples.

Edit Op/Tool and Machine Sim Settings
Clicking this button opens the Settings dialog that allows you to define how Part and Tool
Rendering should look and act. This includes the quality and appearance of the rendering and how
collisions should be handled. For more information, see Settings for Op Sim, Tool Sim, and
Machine Sim

Appearance

The Appearance settings directly affect the look of the GibbsCAMworkspace. Beyond just the
“look” of the workspace, these settings can directly affect the system’s performance. There are
three categories which can each have different settings.
Display
The Display category affects the immediate workspace and solids.

Op/Tool and Machine Sim
This affects how simulation will look and behave.

You can choose from several preset themes, including GibbsCAM 2005 No OpenGL, GibbsCAM 2006,
GibbsCAM 2005 OpenGL, andmany others. You can have different settings for Op/Tool andMachine
Simulation. Or, you can set Op/Tool or Machine Simulation to use the same settings asDisplay by
choosing “Display” from the drop-down list.

GibbsCAM 2005 No Open GL uses the legacyGibbsCAM cut part rendering and behavior. Older
systemsmaywork best under this setting. Note that Op Sim and Tool Sim still work when using this
option, but it closely resembles the legacy ("CPR") rendering. GibbsCAM2005OpenGL has the
legacy look but usesOpenGL to accelerate solids andOp/Tool Sim. GibbsCAM2015 3DS is the
standard display. GibbsCAM2006 CR andGibbsCAM2006 SW are variations on theGibbsCAM
2006 appearance.

Edit Appearance Settings...
Clicking this button opens a dialog that lets you create your own appearance setting and choose
options. This can help speed up the system display.
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Appearance Settings Dialog

Configurations
This list shows the available presets. A red arrow is next to the preset the display is currently set.
These presets cannot be changed but youmay choose one, duplicate it andmodify the duplicate. It
is recommended that you change the name of your custom preset by double clicking the new preset
and changing the name to something you prefer. The items discussed in this section affect the
appearance and performance of GibbsCAM. There are other factors that can have an effect on
performance and appearance. Please see “Appendix” on page 189 for more information on video
cards, video drivers and various recommendations.

Common Tab
The items in this tab control very basic elements of the interface, which apply to all parts of the
system.

Enable OpenGL Acceleration
This item turnsOpenGL on and off. Most of the system (from display to toolpath to rendering) is
accelerated byOpenGL. Therefore, this checkbox should remain selected, except for older or
low-end computers or video cards that do not handle OpenGLwell.

Activate Dialog on RMB
When this option is active, you can bring up the Appearance preferences dialog by pressing and
holding the right mouse button when themouse is positioned over an empty area of
workspace — in other words, not over solids, toolpath, or geometry.

Unzoom on View Change
When this item is active, the systemwill automatically unzoom the part when you change views
using any of the trackball buttons or keyboard shortcuts for the standard views. The systemwill
not unzoom if you perform a pan or rotate.

Semi-transparent Drag Rectangle
When this item is active, the systemwill softly shade the area surrounded by themouse-drag
rectangle.

Semi-transparent Drag Rectangle Drag Rectangle with no semi-transparency
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View Animation Speed
This item controls how fast the transition is between standard views.

Plane Opacity
This item controls how “solid” the CS plane is. The CS plane fills in the grid of the current
coordinate system. The plane can be toggled on and off using the Show CS button in the
floating Taskbar.

Lights Tab
Themodel is lit by up to four lights. Each light’s position around the part can be controlled through
XYZ vector values ranging from –1 through 2551. Alternatively, you can control the direction by
dragging the light across the preview. Each light has a color defined byRGB (RedGreen Blue)
values ranging from 0 through 255. Or, you can click on the color button and select a light color from
the color picker. The color picker is described in “Colors ” on page 23.

Here you see an example of a body lit with four lights. The Faux Shadows option is active.

Colors Tab
You can control the color and transparency of solids, surfaces, andmany other items. The color
picker is described in “Colors ” on page 23.

Material Properties
TheMaterial Properties of bodies can bemodified aswell. This is what kind of material a body
looks like. By controlling Specular, Ambient light, and Shininess values, a body can look like plastic
or aluminum or stainless steel.

Specular
The Specular value is the amount of reflectivity bodies have and color of the reflections. A low
value (color) means that the surface is dull. A high value (a brighter color) means the surface
is very reflective. You can select a color or define the RGB values for this attribute.

Ambient
The Ambient value is color of the non-directional lighting on the part. You can select a color or
define the RGB values for this attribute.
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Shininess
Shininess is the size or intensity of reflections. This is a value from 0 through 255. Low values
create larger highlights (which are less intense). High values create smaller, very intense
bright spots. Here you see two examples of a part with low shininess and high shininess.
The lower shininess settings create larger, less-intense reflections. The high values create
small, more-intense reflections.

Below are some examples of lightingmodes to show you how the different lighting can affect
the shininess. Themodels have two different settings for the part color. The top two bodies
are based on the default settings. The bottom two bodies have a lower specular value and
four light sources.

1. Low shininess
2. High shininess

An example of shininess, using custom light settings.

Pre-selection Properties
The items in this section control the appearance of items onmouseover or mouse hover when

Toggle Pre-Selection Highlighting is in effect:

Solid EdgesWhen active, the edges of a preselected bodywill be shown in the pre-selection.

Halo TransparencySets the transparency of the pre-selection. A value of less than 20 will be
very subtle, whereas themaximum value, 255, will make the preselection opaque.

Halo Thickness Sets the width in pixels of halos and edges that surround pre-selected
elements.

Sim Tab
The items in the Sim tab allow you to define the color of the various items displayed byCPR. You
can change the default color of rendered objects by setting the RGB values or by clicking on the
appropriate color button and selecting a color. Separate colors can be applied to the Stock, selected
bodies (Target), Fixtures, toolpath (Op), interference (Clash), the primary color of the cutting tool
(Tool), the Shank of the cutting tool, and the color of wireframe drawing (Edge). The color picker is
described in “Colors ” on page 23.



MainMenu

20

You can set the transparency level for the stock, fixtures and tools. A value of 0 turns the
transparency off (the item is solid); themaximum value of 255makes the item completely
transparent. Whether the stock and/or fixture is transparent is controlled by the right-mousemenu
of the Render Control palette. The tool transparency is set using the Invisible, Transparent, and
Solid buttons on the Render Control palette.

An example of a transparent fixture.

Background Tab
The items in the Background tab allow you to define the colors of the cut part rendered background.
Both the single color background (defined by the Color setting) and the gradient background can be
customized. The gradient consists of up to four colors, one per corner of the workspace.

Gradient
This option switches the single color workspace to a gradient, making it easier for you to
distinguish between standard rendering and theOpenGL renderingmodes, whichmay be
slower. The colors of the backgroundmay be customized (as seen above) by changing the
default colors.

Draw Axis
This enables/disables the display of a small Red (horizontal), Green (vertical) and Blue (depth)
axismarker in any of the four corners of the workspace. Thismarker can help visualize the part’s
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orientation, and hovering over themarker with themouse enables a temporary trackball.
Choose the location to display thismarker, or turn it off.

Faux Shadows
This item enables the drawing of shadows for bodies. The shadows are not created from light
sources but are instead just to the Bottom, Back or Side of themodel. The shadow can help with
part orientation but can slow the display.

System Tab
These options normally do not need to bemodified. The items found in this tab can help improve the
performance of Op Sim or Tool Sim, depending on your CPU, the amount of memory available, the
video card, the type of monitor and its display. Some experimentationmay be necessary to
determine the optimal settings for any given computer. As a general rule, computers with higher
quality/faster cardswill not need to change these options.

Display Lists
This is a speed optimization. It is recommended to turn this on if you have a fast video card with
128+MB of memory. This option outputs solid geometry to OpenGL display lists. Using display
lists can improve the performance of Simulation and, on some graphics adaptors, provides
performance improvements for rendering all solids. Generally, newer cardswith hardware
geometry acceleration will take advantage of Display Lists. Using this option can require large
amounts of video adaptor memory.

There are two instanceswhere turning off Display Listsmay be useful.

a. If you find that LegacyCPR or Simulation crasheswith some regularity (this is likely the
result a data-management issue with aMachineWorks/graphics cardmanufacturer).

b. Sometimes using display lists can result in fairly slow rendering. This situation is hard to
gauge but it has to do with inefficient display list management inside the graphics card
manufacturer's OpenGL implementation, typically where the card shares video RAMwith
the computer’smemory. A good example is rendering a large contouring passwill be slower
with display lists than without. This is because certain video cardmanufacturer’s OpenGL
implementations are bad at managing display list memory. All the tiny changes to contoured
stock and the data added to the display lists can adversely affect the simulation speed
through inefficiencies.

Partial Updates
This is a speed optimization. Partial Updates lets the system redraw only sections of the display
that have beenmodified. Among newer video cards that use Display Lists, somewill benefit
fromPartial Updates, others will not. Partial Updates is particularly useful in optimizing display
updates in Simulation/CPR during animations and especially when the Steps Per Update is
smaller and animation runsmore smoothly. Please note that some video cards do not support
partial update behavior. The trade-off of using Partial Updates is that on some video cards there
may be situationswhere a part of the display is not drawn correctly.

Vertex Arrays
This option structures solid topology as an efficient point-reducedmesh and uses optimized
OpenGL functions to send data to the graphics adaptor. This option requires additionalmemory
to storemeshes and additional processor bandwidth to pre-calculate themeshes. This can be a
big speed improvement on systemswith a adequate video card, i.e. a lot of memory.
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Soft Shadows
Applies a blurring filter to the projected shadow. In some parts with extreme bounding volume
aspect ratios (likeMTM), soft shadowsmay eliminate all projected feature details. On some
video cards this can have a large impact on solid rendering performance.

Driver
Select the type of OpenGL rendering that will be used in the next graphics session — either the
next part that is opened or the next GibbsCAM session that is launched. The options are:

Hardware
This is fully acceleratedOpenGL. This option usesOpenGL to render all geometry, which
includes solids and toolpath. Thismode requires a redraw whenever an overlapping window
ismoved over the geometric window.

Software OpenGL
This is a software simulation of OpenGL. This is a standard implementation across all
Windows hardware platforms so it should work the same on everymachine, but provides no
acceleration. Thismode does not support shadows and uses the non-OpenGLmethod for
rendering non-solid geometry. This option does not require a redraw whenever an
overlapping window ismoved over the geometric window. This option provides for amore
compatible result but sacrifices speed and power. This option should only be used if your
video card has poor or noOpenGL support, or if you experience unacceptable graphical
issues.

P-Buffer
This is a partially acceleratedOpenGL. This option uses acceleratedOpenGL to render solid
geometry and shadows but, like the Softwaremode, uses the non-OpenGLmethod for
rendering non-solid geometry and does not require a redraw whenever an overlapping
window ismoved over the geometric window. Thismode is not supported on all graphics
adaptors but appears to work well on NVIDIA. This option provides for a highly compatible
rendering system but sacrifices speed.

Facet Body Opacity
This item sets the visibility of facet bodies. Facet bodies are created fromSTL files. See theMill
manual for more information.
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Driver Info

This item opens a dialog that displays the currently available OpenGL drivers on themachine,
their supported extensions, and the amount of currently used and available graphicsmemory.

Test Frame Rate
This item tests the number of times per second that the current display is redrawn.

Colors

1. Standard Colors
2. CustomColors
3. Color Mixer
4. Saturation Level
5. Add CustomColor
6. Use CustomColor

The Rendering Preferences lets you select a color from one of the forty standard choices. Clicking the
Default Color button is the same as clicking Escape, inasmuch as the dialog will close and the color
selection will not change.

To create a custom color, click near the color you wish to use, adjust the slider to select the
saturation of the color, and click one of the two buttons to the right of the color mixer and slider. The
upper color button (“Add CustomColor”) selects the specified color and adds it to the current
custom palette. The lower color button (“Use CustomColor”) selects the color but does not add it to
the custom colors palette.
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Printing

Geometry, bodies, toolpath and rendered images can all be printed by selecting the Drawing item in
the Print submenu. The Printing Preferences section of the Display preferences lets you specify how
the systemwill handle the background color and the colors of the image.
Separate options are available for printing the geometry and toolpath and for the rendered part.
Selecting Screenwill print the drawing exactly as it appears on the screen, with a black background
and the colors as they appear on the screen. Selecting Screen onWhitewill print the image in color,
but on a white background. Selecting Black onWhitewill convert all the colored items to black and
print them on a white background. If the printer being used is a black and white printer, the Black on
White option should be selected to ensure that all portions of geometry, including those that are of a
light color, can be seen in the print. If a color printer is being used, any option can be used.

Bodies

The Bodies section of this preference contains settings that affect the graphic display of bodies and
sheets.

The Render Faces button (found in the Floating Taskbar)
determineswhether bodies and sheets will be rendered
as objects or wireframe drawings. The wireframe
drawings of the solids or sheets will be displayed as either
Edges or Facets depending on the selectionmade forWire
Drawing.

Edges and Facets inWire Framemode

Chord Height
A chord is a straight line that joins any two points on an arc or circle. The chord height is the distance
from the chord to the arc or circle. This setting determines the faceting resolution when bodies and
sheets are rendered. The smaller the chord height, the closer the facet will be to the arc or circle,
resulting in a better rendered image.When the setting is very tight, the on screen drawing of bodies
and Boolean operations can become slow. A setting of 0.01 inches or 0.25mm is recommended for
most systems.

Grid Brightness

The Grid Brightness option is for the Level 2 interface only. This slider controls the brightness of the
coordinate system grid in the stock diagram. The brightness can be adjusted bymoving the slider.
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Other Items

Marker size

You have the option of displaying Small, Medium, Large or Extra LargeMarkers.

Show 'Other' turning toolholders in preview

For Turning inserts when no toolholder has been specified, select this checkbox to display a
"pseudoholder" (rectangle drawing) in the tool preview window.

Lines drawn for high degree curves

This setting is used when higher-order splines are imported into the system. The value specifies the
number of line segments that will be drawn to create the spline. For a smoother spline drawing,
enter a larger number. For the spline to be drawn faster, enter a smaller number. This value only
affects the drawing resolution of the spline, not themachining tolerance.

Settings for Op Sim, Tool Sim, and Machine Sim
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There are separate settings dialogs for Op/Tool Simulation and for Machine Simulation. Both have
virtually the same options but they save separate data files. They are opened by using the Display
preferences tab (File > Preferences > Display):

These dialogs can also be accessed by right-clicking the corresponding rendering dialog.

Performance
Drag the performance slider to choose predefined settings to set greater accuracy or greater
speed, or to choose custom settings.

Cutting
Frames per Second
A greater Number of frames equals better quality, but less speed.
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Cut Part Chord Height

1. Chord Height

This setting is the resolution for the cut part displayed. The smaller the value, the higher quality
of the display and themore resources needed by the system, resulting in a slower rendering,
depending on your system's capabilities.

Body Chord Height
Determines the resolution of bodies (part, stock, and fixtures) in rendering.

Chord Height
You can set the Chord Height to a specific value, or a percentage of the
Body's Chord Height:

The% of Body’s Chord Height option uses the value set in the Properties
dialog. A setting of 100% uses the bodyChord Height while a setting of
10% is 1/10th of the bodyChord Height. Any percentage between 1 and
100,000 is acceptable. As the percentage is set higher, the body displays
faster but appears rougher.

Slider
This item affects the responsiveness and quality of the rendering. The Angle values can have a very
large impact on the rendering speed versus quality, especially on rotary operations. A low number
will create very small angles in rotations, resulting in a smooth image. A high number can create a
rendered part that is not smooth but is very fast. Please note that this does not affect toolpath, only
the rendered part.

For Machine Simulation, the Auto Range checkbox enables the use of the stock size to define
minimumandmaximum feed and rapid lengths.

Feature
Circular Threads
This options renders “circular” threads rather than proper spiraled threads. Enabling this option
will render threadsmuchmore quickly.
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Approximate Arcs
This option renders arc features as a series of lines. Approximated circlesmay provide greater
rendering stability.

Collisions/Program Errors
Collision and ProgramError checking are available for Op Sim andMachine Sim. You can choose
any or all of the various feedbackmethods that alert you to a collision: The Beep option provides an
audible alert; Log To Display outputs errors to the Clash Console log window; and Stock Flash
provides a visual alert to the error by flashing the rendered stock. Stop Animationwill cause the
rendering to stop when a collision is detected.

Collision Tolerance
The Collision Tolerance setting allows a different value for parts in metric and inches. Any collision
within the specified tolerance generates a collision alert.

Gouge Tolerance
Gouge Tolerance allows you to specify how much removed stockmaterial can be ignored without
considering it to be a gouge. Drag the slider to the left to decrease (tighter tolerance), or to the
right to increase (looser tolerance).

Statistics
When the Statistics option is enabled, a window will open when you activate Simulation. The window
logs the current frame-rate for your machine aswell as any logged errors for the CPR session.

Reset
Resets all values to the default .
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Interface Preferences

The items found on this tab affect the basic interactions of GibbsCAM, including its “look-and-feel”.
The items on this tab let you set base size of GibbsCAM, the interface you will use, how dialogs
behave, selection behavior, andmany other things.

Window Size

This option determineswhether the application will occupy all of your monitor (Start Maximized) or
will be in windowedmodewhen you launch the application. Selecting the Enable Captionwill leave
the blue bar visible (the caption bar shows the name of the application and has a Close box).
Deselecting this checkboxwill hide the bar so that themenu bar is at the top of your screen.

When the application is not maximized, you can resize the window by dragging an edge or corner.
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Dialogs

Transparent Dialogs

Selecting this option allows each dialog to have a custom transparency setting. You can also set
a default transparency setting that all applies to all dialogs until they are customized.

When Transparent Dialogs is in effect, the title bar of each dialog includes an icon ( ).

Click the icon to bring up a slider that lets you set a custom transparency for the dialog.

If Transparent Dialogs is not selected, the icon is hidden and all dialogs are opaque.

Window Snap Positioning
Enabling this option will cause windows and dialogs to “snap” to nearbywindows. This allows
for easy and neat arrangement of windows.

Dialogs Roll-up
Selecting this option will cause dialogs to automatically “roll up” to show only their title bar when
themouse leaves the dialog.When themouse enters the title bar, the dialog unrolls to show its

contents. Enabling this option adds an icon to the title bars. When the “pushpin” is down ( ),

the dialog does not roll up. When the pushpin is up ( ), the dialog can roll up.

Dialogs Follow Application
Selecting this option will cause all windows and dialogs to follow the application window if it is
moved.



MainMenu

31

Lock Solid/Surface Palettes
This option affects the Solid Modeling and SurfaceModeling palettes, the sub-palettes and their
dialogs. Selecting this option will cause the sub-palettes and dialogs to follow the Solid Modeling
and SurfaceModeling palette. When the parent palette ismoved, all palettes and dialogs
accessed from this palette move along with it.

Floating Toolbar Transparency

This allows you to specify the degree of transparency for the Taskbar and custom floating toolbars.
Select Enable to change the default values. The value for On specifies toolbar opacity when the
cursor hovers over a floating toolbar item. The value for Off specifies toolbar opacity when the
cursor is away from the floating toolbar. The default valuesmake floating toolbars almost opaque
(80%On) onmouseover, and almost transparent (20%Off) the rest of the time.

Level

The Interface preferences allow users to toggle between the Level 1 and 2 interfaces. Although
users should use the interface that best suits their needs and knowledge, using the Level 2 interface
is recommended. This is because the Level 2 interface is amore refined and optimized interface,
providing a richer environment for the user.New and Current Part lets you specify the default level
interface the system should use.Open Part lets you designate whether the systemwill open an
existing part with the interface level that the part was originally created in, or with the interface level
that the system is currently running.

Level 1
This interface provides full functionality to the productionMill and Turningmodules, using the
Command Toolbar. The full functionality of Level 1 does not, however, encompass Advanced
CS, TombstoneManagement System (TMS), Multi-TaskMachining (MTM), Solids Import,
2.5D Solids, SolidSurfacer, or Machine Sim capabilities.

Level 2
The Level 2 interface gives users themost advanced set of features, including the Command
Toolbar and floating Taskbar. The Level 2 interface is necessary for using product options
Mill/Turn, Polar & Cylindrical Milling, MTM, Advanced CS, Solids Import, SolidSurfacer,
Machine Sim, or TMS, and is available to all users.

Open Part
This defines the interface level an existing part will be opened in. Part opens a vnc file and sets
the interface level to match the level used to create the file. Current opens a vnc in the interface
level currently in effect.

Selection

Targeting Pixel Tolerance
This setting specifies the accuracy you need to have when you select an item in the workspace.
The default setting, 5 pixels, means that the workspace item is selected if it lies within 5 pixels of
the cursor tip when you click themouse, and not selected if it lies 6 or pixels from the cursor tip. If
more than one element is within range, the system selects the closest geometry.
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Floor/Wall Angle Tolerance
This item is used with the face selection options found when right-clicking on a solid. Any face
that falls within the tolerance specified in this dialog will be selected. For example, when
selecting wall faceswith the default setting of 10°, any face at an angle from 80° to 100° of the
selected face will become selected.

Face Blend Tolerance
This item is used with face selection. When selecting fillet faces, Face Blend Tolerance is used to
detect rolling ball fillets.

Other Items

Always show tool preview on hover
Specifies whether a preview of the tool is shownwhen you hover the cursor over a tool tile.

Zoom to Mouse Cursor
For scrollwheel zoom actions: If the Zoom to Mouse Cursor checkbox is selected, then the zoom
center is the cursor; otherwise, the zoom center is the window center.
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Zoom to Mouse Cursor not selected (top): Window-
centered zoom

Zoom to Mouse Cursor is selected (bottom): Cursor-
centered zoom

Automatically Check for Updates on Startup
When this checkbox is selected, the systemwill check if a newer version of the software is available
for download. Uncheck to disable this function.

Open Process Dialog on Op Load
When this checkbox is selected, the process pialog will open whenever the user double-clicks an
operation.

Usage Statistics
WhenGibbsCAM is installed, a dialog asks permission regarding the collection of usage statistics.
These consist of general technical data (such asOS platform and graphics subsystem) aswell as
softwaremodule statistics that are specific to GibbsCAM, such as frequency of library/module calls
andGibbsCAM software performance. No personally identifiable information is ever collected
(such as company name or user name, computer or network ID, or the like), and no information on
part design or part names is ever collected. Information is never collected without permission, and
permission can be withheld either by the system administrator or (if the administrator allows it) by
GibbsCAM.com users.

At installation time — or at any other time by running Bin\GCStatsAdmin.exe — the administrator
chooseswhether to opt in or out of usage data collection, and also specifies whether or not to
permit individual users to override the administrator’s choice.

If users have this permission, they can exercise it as a preference: File > Preferences, Interface tab,
Usage Statistics button. Any changed setting takes effect immediately upon clicking theOK button.
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License Update

The License Installation or License Update dialog lets you drag a license onto the dialog for application
installation, browse the computer for a license file, or run the Registration Tool to obtain a license
file through theGibbs Activation Service.

• If you already have a license file for v13 or earlier, however, you can simply drag and drop it
onto this dialog, or click Browse for your license file on this computer... to navigate to it and select it.

Reseller Activation - If your Reseller will be assisting you with your installation,
have your registration files (and hardware keys, if any) ready in advance.

License Options
This preference is only available to users of the Network Licensing option. This preference allows
users to specify the licensing options to be checked out from the license server. Select the options
you wish to use and click Check Out. If the options you want to use are available, you can then click
OK; otherwise, you will need to select other product options.

This is useful when a full compliment of product options is unavailable or unnecessary. For
example: Suppose your company has fiveMill seats, five Advanced CS seats, and three
SolidSurfacer seats. Even if three other users are currently using SolidSurfacer, you can still check
out aMill and Advanced CS seat, because there are two open seats for each option.
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Digitizer Calibration
This preference allows a user to set the functionality of a tablet. The default setting is Tablet as a
mouse.

Tablet as a digitizer in three places: 1) Calibration 2) Mouse Point, 3) Mouse Line.When the Tablet as
a digitizer setting is selected, calibration pointsmust be entered. Any three points on a part print can
be used for this purpose. Place the cursor in a text box, select a point on the print with the digitizer
puck, and enter the X and Y values. Repeat this process for twomore points.

Calibrationmust be performed for each part you wish to digitize, and the calibration does not persist
across instances of GibbsCAM. The calibration can be performedwhether a part is open or not.

Machining Preferences

TheMachining Preferences tab contains several settings for the system’s behavior when generating
toolpath.

Default Mill/Turning CRC Type
This option allows you to set the default behavior of Cutter RadiusCompensation in operations.
This is a default; for any particular part, you can override this default in the DCD (Document Control
dialog), Machining Preferences tab. The Default CRC Type options include Tool Center, Tool Edge,
Finish Profile and Last Used. The toolpath displayed on-screen will not change with each selection,
but the posted output will vary according to your selected preference. Additionally, if you convert an
operation’s toolpath to geometry, the resulting geometry will be reflective of the CRC Type used.

When using custom form tools for turning-type parts, do not use the Tool Edge setting, because the
entirety of the form tool is used in the calculation. Tool Center is the recommended option because
that is themethod used by the system to display the toolpath (orange lines) and cut part rendered
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images. Regardless of the setting you choose, all toolpath drawing and cut part rendering display
as tool center.

Tool Center
The toolpath is rendered on-screen this way regardless of which CRC type option is selected.
With this option, the toolpath is calculated to the center of the tool including any stock settings.
When using Tool Center, the offset in the CRC register at the control should be the difference
between the tip radius of the actual tool used and the tip radius of the tool programmed in the
system. If the tools are identical, the CRC offset number should be zero. If the actual tool is
smaller, you can use a negative value.

Tool Edge
With this option the toolpath is calculated to the edge of the tool including any stock settings.
CRC offset settings on the control should be set to the tool size.

The offset in the CRC register must be the full tool radius. Toolpath is to the tool edge, including
tool geometry. You also need a post processor that supports Tool Edge output. If your post
processor is incompatible, a warningmessage appears. Numbers generated in the posted code
are the same as the blueprint numbers. When you select Tool Edge, the toolpath lines still display
as tool center. Tool Edge only affects the posted code. Toolpath in Roughing operations is
calculated from the tool center, unless in Tool Edgemode, in which case, (because we apply
CRC to the last pass only) the last passwill be calculated from the tool edge.

When using Tool Edge, you should enter the radius of the actual tool in the CRC register. If you
use tapered tools or tools with corner radii, youmust calculate the appropriate offset amount
based on the taper.

You cannot enter negative line lengths in Tool Edge CRC approach/exits. Thismeans
there is no way to have an arc only approach.With tool center you simply set the line
length to “0”. With tool edge you have to enter line length equal to -tool radius.

Finish Profile
With this option, the toolpath is calculated to the finish geometry of the part and does not include
stock. TheG-code output is essentially a blueprint of your part. CRC offset settings on the
control should be the tool size, plus any stock allowance. This option supports Rough Bore,
Finish Bore, Contouring andOffset Pocketing operations. For pocketing and rough bore
operations the CutWidthmust be greater than the tool diameter otherwise tool center is output in
the code. This option ismeant to be used as a finish pass.

Last Used
This option keeps the CRC offset setting currently in use.

WARNING: The system does amuch better job offsetting the tool than themajority of
controls currently available. Regardless of the settingmade in this preference, all
toolpath drawing and cut part rendering is calculated and displayed using the
system’s offsettingmechanism. Therefore, it is possible for the cut part rendered
image produced by the system to look good while the tool, cutting according to the
posted code, will not cut well. If the control’s offsettingmechanism is less advanced
than the system’s, it is possible that when the control produces the offset values,
errors and interference will result.
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What exactly ismeant by arc radius and line length in CRC? The arc radius is to tool centerline for
all CRC types. Line length is the distance you want the tool edge to start away from the geometry
start point.

1. MachiningMarker
2. Process dialog Line value

90 degree Line Approach

With Tool Center the line length and arc radius are tool centerline distances, meaning that a 90°,
9mm radius tool centerline arc will bring the tool edge down 9mm from the finish wall.

Tool EdgeCRC defines the line length and arc radius in terms of edge position. If you specify “0” for
the line length, the tool edge starts on the geometry, and a tool radius-long line will be output in the
G-code for CRC to turn on. This results in “nomove.” If a line-arc entry is used, you have to
visualize the equivalent finish geometry approach radius that will result from the arc radius
specified. The line length ismeasured from this finish geometry arc start point.

1. Tool Edge to part = centerline radius

Tool Edge Entry

Please note that the toolpath for “0” length approach/exit lines are drawn incorrectly. The output
toolpath appears to be correct. You can check the output toolpath by converting an operation to
geometry. The orange toolpath line drawn is not the output toolpath, but rather a prediction of actual
tool motion from turning CRC on/off. If you set the preferences to Tangent Entry Line to Arc, and Tool
Edge, it is easy to see how these valueswork. The very first move is an angled line. The tool
positions at a finish geometry equivalent position at the start point of the entry line. We assumeG41
will be applied on the first move, and the orange line angles over to the start point of the centerline
toolpath. This stays centerline until CRC off on the last line.
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1. Turn on CRC move
2. Entry radius
3. Resulting Tool edge arc
4 .Finish geometry to G-code

Tool EdgeG41 start

Holder Class Menu Items
This item allows you to select whichmill holders show up in the Document Control dialog. Most
users will not have all classes of back ends available so this item helps youminimize an otherwise
long list of items.
Ignore Lathe Max Feed Moves
When this checkbox is selected, no turningmoveswill usemaximum feedrate. Instead, anymoves
programmed forMax feedrate will continue at the feedrate immediately preceding. This is normally
Contour Feed, unless the preceding utilitymarker was changed — to User, for example. Please note
that if your Post Processor waswritten before this option was available, you will need to get it
updated.

Legacy Tool Edge CRC Entry/Exit
Check this option to enable output of values along the Entry and Exit Angle in G-code, but the
motion will deviate by a tool radius. The default is unchecked, where the Entry/Exit motion
displayed will match the Entry/Exit angle, but the G-code will show values that differ by a tool radius.

Hole Wizard
The Hole Wizard section contains buttons to access the preferences for Hole Data. These preference
settings control the behavior of the HoleWizard. In addition a predefined list of bolts and tap
definitions can be accessed here. The Bolt Table and Tap Table dialogs are spreadsheets that
contains standard data and user entered definitions of bolts and tap holes. These items are fully
described in the Features guide.

Hole Manager
Opens a dialog which enables setting of preferences for HoleManager. This is fully described in
the Features guide.

5-Axis Preferences
Opens a dialog which allows you to set caching parameters for 5-Axis toolpath calculation. Caching
uses additional space to speed up Redo performance during a session.

For example, if 5-Axis toolpath has been created during a session, then enabling cachingmeans
that a Redo of that toolpath will recalculate only the changed data instead of recalculating all data.
For complicated toolpath and a location with fast I/O, such as an SSD (solid-state drive) or EFD
(enterprise flash drive), this can significantly improve performance.
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File Preferences

The items found in the File tab determine how GibbsCAM reads and writes items in files.

Undo Memory
This value determines the amount of memory space inmegabytes to be reserved for performing
Undo functionality.

Save Size
This preference lets you control the size of the files that have solids. The files can be saved as a
Large orMinimal (without facets) file. Saving without facets creates a smaller file, but will require more
time to regenerate the facets when the file is opened. On slow systems, this regenerationmay be
quite long, depending on the size and number of solids.

Alert When Overwriting Post Output File
This option will present an alert if you overwrite an existing NCF file when generating a post. This
option will also open a Save dialog, allowing you to select a different name for the new post,
protecting the older file.

Launch New Application on File
This option dictates how the systemwill respond when a VNC file is opened. If Launch New
Application on File is selected, a new instance of GibbsCAMwill open with the selected file. If this
option is not selected, the file will be opened in the current instance of GibbsCAM. If a file is already
open, you will be prompted to save the open file if necessary.
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Use Default Part When Opening Non-VNC Files
Enables theMDD or Machine Type Default Part to be loaded before importing files with the Open
command. If unchecked, Open imports the file into an empty part.

Cutdata Path
The system looks for theMaterials Database file in the path and filename specified here. The
default path is C:\ProgramData\CAMBRIO\GibbsCAM\<version>\.

• If you have not purchased CutDATA, theMaterials Database file has the default name
Material.txt if empty, or else, if it contains custom data, MATERIAL.txt.

• If you have purchased CutDATA, theMaterials Database file has the default name
CutDATA.txt.

In either case, youmight want to name the file something else (not recommended), or youmight
want to keep the file in amore central or convenient location such as theMyDocuments folder or the
desktop. Clicking the Browse button lets you define where the system should look for your material
database file.

Font Directory
This preference allows you tomanually set the font directory that will be used in the Text Creation
dialog. Some usersmay designate a different folder for engraving fonts tomake selecting a font
easier than sifting through a listing of all available fonts on a system. The system automatically
determines the location of the operating system’s Fonts folder; for most users, therefore, this
preferencemay be ignored. However, if the fonts that will be used for engraving are not kept in the
default system fonts folder (C:\WINDOWS\Fonts), this preference will be necessary. Simply
highlight the target folder that has the engraving fonts and click onOK. Please note that only
TrueType fonts can be used with the system’s Text Creation function.

Additional VMM, MDD & MachineSim Path
This preference allows you tomanually set the directory where the system looks for VMMs, MDDs,
andMachine Simmodels.

Accelerated Process Loading
Significantly increases system performance for loading process lists and tool lists, using additional
memory.
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Import/Export Preferences

The items found in the Import/Export tab affect how data is translated to and fromGibbsCAM.

File Extension
These preferences set the extensions that will be added to different types of files that are created by
the system:

• The extension associated with Post is added to the text file generated by the systemwhen a part
file is post processed. The default extension is NCF.

• The extensions associated with IGES, DXF, and Point List are used when importing and exporting
geometry.

• The extensions associated with Parasolid, SAT, CATIA V4, and VDA are used for importing and
exporting solids files.

Each entry in the dialogmay containmore than one extension for a type of file. For example,
Parasolid filesmight have the extension x_t or xmt, depending on the application that saved the
file. Multiple entriesmust be separated by a comma and a space.

Choose Solidworks Configuration upon import
SolidWorks configuration allows the creation of multiple variations of a part or assembly within a
SolidWorks file. If checked, a dialog will appear during import to enable selection of the
configuration.
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Unchecked, the active configuration will be used.

Default Translators
This section allows you to specify which import/export option will be used by default on operations
like File > Open or drag-and-drop. For more information, see the Data Exchange guide.

Auto Save Preferences

GibbsCAMhas the option of automatically saving the file you are working on. You should be aware
that saving will purge any available Undos and Redos.

By default, auto-saved part files are saved in the same folder where theywere opened. You can
override this default by selectingOverride Backup Location and specifying a backup directory.

You have the option of saving As Backup file. Selecting this option has the advantage that you can
continue working on your current file as normal, with redo and undo available. The backup file
created is a temporary file that can be automatically deleted when you closeGibbsCAM (although
you can override the automatic deletion if you want). The backup file is used only if the software
crashes before you closeGibbsCAM.

Coordinate Systems Preferences
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The Coordinate Systems tab allows users to set the guidelines for the automatic creation of new
coordinate systems. It is recommended that beginning users check all of the items in theNew CS
section. This will result in more coordinate systems being created but geometry will not bemodified.

These preferences affect the associativity between coordinate systems, geometry and toolpaths.
When these items are all unchecked, geometry and toolpathsmay change their position to reflect
modificationsmade to the coordinate system onwhich they are based. In some cases, thismay not
be a desired effect, so these preferences have been included to give the user control over CS
associativity.

Self Definition
This has an effect whenmodifying a CS and geometry is selected.

- When this item is checked the systemwill automatically create a new coordinate system
rather than updating the current CS. This will only occur if geometry was selected tomodify
the CS and it is assigned to the CS beingmodified. The result is that the geometry selected
for themodification will not change its location. The geometry will still be based on the
coordinate system in which it was created rather than having its location in 3D spacemoved
to reflect the new CSmodification.

- If this item is unchecked, anymodifications to a CS will result in geometry in the CSmoving
with the CS.

Geometry References
This has an effect whenmodifying a CS that contains geometry.

- When this item is checked, if a modification ismade to a CS that was used for existing
geometry, the systemwill create a new coordinate system rather thanmodify the current
CS, which would result in moving the geometry.

- If this item is unchecked, anymodifications to a CS will result in geometry in the CSmoving
with the CS.
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Toolpath References
This has an effect whenmodifying a CS that was used for machining.

- When this item is checked, if a modification ismade to a CS that was used as theMachining
CS for an operation, the systemwill create a new coordinate system rather than adjust the
current coordinate system. This prevents the changing of the position of toolpath.

- If this item is unchecked, anymodifications to a CS that was used for existing toolpath will
result in modified toolpath.

Out of Plane Rotation
This has an effect whenmodifying a CS that was used for machining.

- When this item is checked, the systemwill automatically create a new coordinate system
anytime geometry is rotated out of the plane in which it was based. Rotating out of plane
would be rotating geometry along its horizontal or vertical axis, as opposed to about its
depth axis.

- If this item is unchecked, geometrymay be rotated and the CS will not bemodified.

Set New CS Visible
When this is checked, the CS Frame Indicator will be displayed on the screen for anyCS that is
automatically created by the system based on these preferences.

Post Processor Comments
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The Post Processing preference allows the user to specify comment data that is output in the NCF
file generated by the system. If an item is checked, that data will be output. At the end of this section
is a simple program that showsmost of these options in use.

Extended Characters
Selecting this option will allow characters beyond the ASCII 1-128 character set to be output in the
post. Your machine should support non-English character sets to use this option.

Program Name
This itemwill output the name of the part file at the beginning of the program.

Program Comment
This itemwill output any comment entered in the Document Control dialog “Comment” section. The
comment will be placed in the program header.

Format Code
This option will output the ID number of the post processor that was used to generate the program.
The ID number will be placed in the program header.

Format Name
This option will output the exact name of the post processor that was used to generate the program.
The namewill be placed in the program header.

Date and Time
This option will place the date and time the programwas created in the header.

Absolute or Incremental
The programwill include in the header whether the output is absolute or incremental.

Number of Parts
This outputs the number of parts being posted in the program header.

Starting Tool State
This option outputs whether the post processor expects the first tool to be in the spindle or tool
changer.

Special Functions
By default this option is off. When active, the post outputs an explanation of Utility Data commands
that are available with this post. This is potentially a significant amount of text.

Operation Number and Type
With each new operation in the program the operation number and type will be output.

Operation Comment
This option will output any comment associated with the operation at its start in the program.

Workgroup Comment
This option outputs the workgroup name at the start of each operation.

Tool Number and Type
This option outputs the tool number and type at the start of each operation.

Tool Comment
If there is a comment associated with a tool, it will be output at the start of the operation.
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Length in Characters
This option will output the program length in characters in the program footer.

Length in Feet
This option will output the program length in feet in the program footer.

Length in Meters
This option will output the program length in meters in the program footer.

Sub Number
In operations that have sub-routines, the sub-routine number will be output as a comment.

%

O1( PROGRAM: POSTEXAMPLE.NCF ) ProgramName

( THIS IS FROMTHE DOCUMENTCONTROLDIALOG. ) ProgramComment

( FORMAT: FANUC 6M [VG] M001.19M.PST ) Format Name

( 3/21/06 AT 3:57 PM ) Date and Time

( OUTPUT IN ABSOLUTEMILLIMETERS ) Absolute or Incremental

( PARTS PROGRAMMED: 1 ) Number of Parts

( FIRST TOOLNOT IN SPINDLE ) Starting Tool State

N1G17G40G80

N2T1

N3M6

( OPERATION 1: HOLES ) Operation Number and Type

( DRILL A SINGLE 13MMHOLE ) Operation Comment

( DRILLINGWORKGROUP ) Workgroup Comment

( TOOL 1: 13. DRILL ) Tool Number and Type

( 13MMDRILL ) Tool Comment

N4G54

N5S3000M3

N6G90G0X20.Y20.

N7G43Z50.H1

N8M8

N9Z2.5

N10G81G99X20.Y20.Z-53.906R2.5F250.

N11G80G0Z2.5
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N12M9

N13G91G28Z0.

N14M5

N15M30

%

( FILE LENGTH: 502 CHARACTERS ) Length in Characters

( FILE LENGTH: 4.46 FEET ) Length in Feet

( FILE LENGTH: 1.43METERS ) Length in Meters

A simple program showingmost of the available post options in use

Communication Setup Preferences

To send a post file to a CNC machine, the parameters for data transfer must be set up in the File >
Preferences ComSet-up dialog. This dialog is used to set up two-way communications for
transmitting data between a control and workstation. Different controls have different protocols or
parameters. Refer to themachine control’smanual for the protocol specifications.

Adding a Protocol
To add a new communication protocol, enter the name of the new protocol, change the settings to
match those of the CNC machine, and click the Add button. The new protocol will appear in the list.



MainMenu

48

Changing a Protocol:

To change protocol information, select the protocol from the list and change the information. The
changes are automatically saved when the dialog is closed or when a different protocol is selected
in the list.

Removing a Protocol:
To remove a protocol, select the desired protocol from the list and click the Remove button.

Intermediate Tooling Preferences

This lets you set the default folder used for Intermediate Tooling.
You can set the default view to either Quick View (static image) or Dynamic View:

• Quick View is suitable for slow systemswith underpowered graphics.

• Dynamic View is recommended for most systems, because you can pan, rotate, and zoom the
preview usingmany of the samemousemovements and keyboard shortcuts that you use in the
workspace, like CTRL-drag to pan, center-mousebutton-drag to rotate, marquee to zoom in,
CTRL+U to unzoom, and so forth.
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G-Code Editor Settings

This lets you select an application for displaying and editing post files.

Editor Choices

When a post file is processed, the systemwill automatically launch the application of your choice
and display the posted output.

No G-Code Editor
You can choose to disable the editor, in which case you will still be able to look at the output in the
post Processor dialog window.

Internal Editor
TheGibbsCAMbuilt-in G-Code editor provides the following features:
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• Editing and file capabilities, such as Cut/Copy/Paste, Undo/Redo, and Save/Save As.

• Context colors that distinguish at a glance items like code, code labels, and parameters within
individual G-codes andM-codes.

• The ability to edit multiple subs. Each sub occupies its own tab in the window.

• When editingmultiple flows, you can choose either independent scrolling, where each flow is
independent of all others, or synched scrolling, where eachG-code stream is padded as
needed so that separate flows remain aligned according to their syncs.

• Customization: You can set colors and font however you like, and you can edit and create sync
definitions.
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If you require the G-Code editor to be permanently displayed, open it from the Plug-Insmenu using

OpenG-Code Editor. If you have your own editor, this can also be opened from the Plug-Ins

menu using External G-Code Editor.

Custom Application
Any application that can open and read ASCII text files such asNotepad or Word can be used as
your custom editor. Click the Browse button to locate the custom editor you want to choose.

You can select the Advanced Options checkbox if you want to use the ability to pass variables to the
custom editor. When this option is enabled,  %f passes the filename; %p passes the path down
to the folder that contains the file; and %s passes the path and filename.

Additive Preferences

This lets you set the default data folder used for AdditiveMachining.

Materials
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TheMaterial Database with and without CutDATA

Materials database is available from the File menu Materials. TheMaterials Database is used
for storing and quickly retrieving feeds and speeds recommendations for various types of materials.
All Materials Database informationmust be entered by the user unless the CutDATA™material
library has been purchased. To access the database, you can also click on theMaterial
button in any of the process dialogs.

If you have not purchased CutDATA, theMaterials Database file has the default name
Material.txt if empty, or else, if it contains custom data, MATERIAL.txt. If you have purchased
CutDATA, theMaterials Database file has the default name CutDATA.txt.

The database is set up in a hierarchical format. A Family can containmore than one Alloy group and
is at the top of the hierarchy.Within the Alloy group(s) you can then specifymaterials. Materials are
sorted into hardness ranges and cut types.When you select an alloy group the Alloys text field
becomes active, where all of alloys that fall into the alloy group can be listed.
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Materials Dialog

1. Family
2. Alloys textbox
3. AlloyGroup(s)
4. Material data list
5. Suggest button 

6. Calculate RPMbutton
7. Calculate Feed Button
8. Comment
9. SFPM (SMPM)
10. ipr (mmpr)
11.Cut diameter (Turning)

Family
The dialog above shows some of the different families that comewith the CutDATA™ database.
When a family is selected, the Alloy Group list will fill up with the groups that are part of this family.

Alloy Group:
An alloy group contains a list of all the alloys that fall into amaterial family and can bemachined with
the same parameters. When an existing alloy group is selected, thematerial list will fill up with
materials.
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Alloys
This is a large text edit boxwhich if using CutDATA, already contains a list all of the alloys that are in
the alloy group. The information in this box is available to edit when an alloy is selected.

Material Data List
Thematerials in this list are grouped together by cut type, hardness, and toolmaterial.

Comment
If a comment has been entered, it will be displayed here.

Edit Material
To edit material information:

1. Select a Family, Alloy Group and Cut Type.
2. Click thematerial you wish to edit.
3. Type the information required.
4. Close the dialog. The information is updated in theMaterials list.

The following settings are only available from the Edit Material or New Material dialogs.

Hardness
The text in this field is used to set up different hardness ranges that can all bemachined with the
same settings for a specificmaterial.
Condition
This is the condition of thematerial. It is related to the hardness value. It is only used for reference
and will not affect any calculations.
XY Depth
This box is used to enter the depth that the tool will be buried into thematerial. The axes change
depending on the cut type selected.
Tool Size
This is the diameter of the tool.
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Tool Material
This dropdownmenu is a list of the availablematerials for tools.
Cut Type
This dropdownmenu is a list of the different cut types available in the database.
SFPM (SMPM)
The value in this boxwill be used as the suggested Surface Feet Per Minute (or SurfaceMeters
Per Minute for metric) when amaterial is selected.
ipr (mmpr)
The value in this boxwill be used as the suggested Inches Per Revolution (or Millimeters Per
Revolution for metric) when amaterial is selected.
Comment
This box allows an additional comment to be displayed when thematerial is selected in the
Materials dialog.

Please note: When deleting any item in the Materials Database (Family, Alloy Group or
Material), great care must be taken as the undo function is not available.

Import Material
Click this button to open a dialog where you can navigate to and select a tab-delimited *.txt file
that defines amaterial.

Importing a Material into the Database

The ImportMaterial lets you import custommaterial data can be imported into theMaterial
database. This option can be used whether you have purchased the CutDATAMaterials database
or not. This function lets you define new material types and cutting parameters in an external file
and perform a bulk import into the database, either adding to the existing data or creating an entirely
new database of your own. The datamay be created in any application that can save or export a
tab-delimited text file, such asMicrosoft Excel or Notepad. A spreadsheet application is
recommended for its ability to clearly view your data.

Click the ImportMaterial button, navigate to the correct folder, and open the file that contains your
custom data.

By default theMaterials Database is stored in the GibbsCAMglobal data folder:
C:\ProgramData\CAMBRIO\GibbsCAM\<version>

The default name of a CutDATA file is CutDATA.txt; the default name of an emptyMaterials
Database file isMaterial.txt; the default name of a customizedMaterials Database file is
MATERIAL.txt; the all-uppercase letters indicate that custom data is present. If the file does not
exist in this folder or a location you specify in the File > Preferences > File I/O, then an empty database
file is automatically created when launching the application. Regardless, any importedmaterial will
be added to the currently specified file.

The import process only adds data, it will not overwrite any existing entries. It is therefore possible
that youmay have duplicate entries. The duplicates can be deleted using the Delete Material button.

Fourteen data categories are supported. Each new material entrymust be on a single line and
theremust be a tab between each entry. All categoriesmust be entered; if a material you are
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defining does not have an entry (typically a comment), then the categorymust be entered as
“NULL” (without quotes). Each category has a particular type of data it can read. A “string” is text
and a “real number” is any non-irrational number, e.g., -4, 0, 8, or 0.1215.

Category Type of
data Example

Family string Alloy Steel, Cast

AlloyGroup string Low Carbon

Alloy Comment string This is a low carbon steel alloy casting

Hardness string Over 50 HRC

Condition string Carburized &/or Quenched and Tempered

ToolMaterial string † Carbide Solid

Cut Type string ‡ EndMill, Peripheral

Cut Depth real
number 75

Tool Size real
number 6

Surface Feed real
number 45

Inches per revolution or
Millimeters per thread

real
number 0.102

Use Comment 0 or 1 0 for no comment or 1 for using a comment

Comment string NULL (if there is no comment)

Metric 0 or 1 0 for inch or 1 for metric

† These stringsmust match strings in the current Material Database dialog. That means the Tool
Materialmust be

HSS HSS TiN Coated

Carbide Insert Carbide Solid

Diamond Other.
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‡ These stringsmust match strings in the current Material Database dialog. That means the Cut
Typemust be

Boring C. Bore Drilling

EndMill, Peripheral EndMill, Slot FaceEdit Mill

Reaming Spotface Tapping

Turning Cutoff Thread.

Following is an example of amaterial entry as seen inMicrosoft Word. The arrows represent tabs
and the pilcrow (¶) is a return.

Alloy Steel, Cast→Low Carbon→ This is a low-carbon steel alloy
casting→Over 50 HRC →Carburized &/or Quenched and Tempered→Carbide
Solid→End Mill, Peripheral→75→6→45→0.102→0→NULL→1¶

• The data is not case-sensitive, but it is language-sensitive. In other words, if you
are running a French or Spanish version of GibbsCAM, then the ToolMaterial and
Cut Typemust be localized.

• If an entry is not complete, it will be skipped; that is to say that if an entry has only
13 tabs, the entire entry will be skipped or if it has an empty field (it does not have
“NULL”) it will be skipped. If an entry is skipped, then the import processwill move
to the next valid entry and will continue from there.

• The importation process is immediate and cannot be interrupted.

Selecting Material from within a process dialog

Clicking theMaterial button fromwithin a process opens theMaterials Database. Select amaterial
by clicking first the Family, then Alloy, then thematerial required. Once thematerial has been
selected (it is now highlighted in blue) you can populate the Speed RPM, Entry, and Contour Feed in
the process dialog from the data set up in theMaterials Database, either by clicking the buttons in
the process dialog or the Calc RPM and Calc Feed in theMaterials dialog.

The following buttons are only active when the dialog is accessed through a process dialog.

Suggest
Clicking this button will tell the software to select thematerial in the list that most closely represents
the cut condition of the open process dialog. First it will try to match the cut type. Then it will match
hardness, depth of cut and toolmaterial.

Calculate RPM
This button calculates an RPM value and places it into the process dialog.

Calculate Feed
This calculates a feed value and places it in the Feed textboxes in the process dialog.
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The Edit Menu

The Editmenu contains options that enable you to adjust and
select file contents.

1. The actions and clipboard sections are the standard
Windows commands for removing and inserting text and
features. You can set the amount of memory allocated to
"undo/redo" in the File Preferencesmenu.

2. Select and deselect,
3. Geometry Expert. These four commands are used with
Geometry Expert.

4. If changes have beenmade to part geometry or solids,
selecting Redo All Ops will automatically reprocess all of the
operations and the new toolpath will reflect the changes.   
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Clipboard

TheClipboard is used as a temporary storage space for geometry, solids, text, tools and process
tiles. You will find the clipboard from theMainmenu > Edit> Clipboard. You can also use the
standardWindows keyboard shortcuts.

Cut option (Ctrl+X) will delete whatever items are selected and place them on the Clipboard.
Any contents of the Clipboard will be replaced at this time.

Using Copy (Ctrl+C) will perform the same action asCut, but will not delete the selected item,
and place a copy of the item in the Clipboard.

Choosing Paste (Ctrl+V) can do two things. If something is selected, it will replace that
selection with the contents of the Clipboard. If nothing is selected, the contents of the Clipboard will
be pasted in either the drawing window or in an active text box depending on whether the Clipboard
contains text or geometry.

The Clipboard can only hold one selection at a time. Thismeans that it can hold either text or
geometry, but not both. If text is copied into a Clipboard holding geometry, the geometry in the
Clipboard will be lost.

Cut and paste is an easyway tomove geometry betweenWorkgroups in the same part file. You
can alsomove geometry, solids, tool tiles, and process tiles between parts. If you are Cutting and
pasting items betweenGibbsCAM instances, theymust be the exact sameGibbsCAM version for
the paste to work. Items can be Cut, Copy and Pasted even after closing GibbsCAMand
relaunching it. If you copy Processes, the systemwill automatically recreate the tools that are
associated with the Processes. Please note that you can only copyWorkspace items (geometry
and solids) or items in the Tool or Process list.

Select and deselect
Selection

Select/ Deselect All

Select/deselect all available workspace items
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Invert Selection

Selected items are deselected and all unselected items are now selected.

Select/Deselect by Attribute

This item opens a dialog box that lets you specify an attribute, comparator, and comparison value.
When you click the Select button, all elements and bodies that match are added to the selection set;
when you click the Deselect button, all elements and bodies that match are removed from the
selection set. For information on attributes and comparisons, see the Features guide.

Mouse Drag

When theMouse Drag item is selected, you can drag the cursor around an area to select all the
geometry contained in that area. This is equivalent to holding down the Shift keywhen click-
dragging themouse.

Select Special

Circles

There are three circle selection options. All Circles will select all circles in the current
workgroup. Full, Radius and Full, Dia. Rangewill bring up the following dialog boxes.

Full Diameter Range

This dialog allows you to select all full, unterminated circles in the current workgroup whose
diameter is equal to or between the value range entered in the text boxes.

Full, Radius

This dialog allows you to select all full, unterminated circles in the current workgroup with a
radius equal to the value entered in the text box.
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Points
The Points selection options are as follows:

All Points will select all points in the current workgroup.

Connectors will select all points used to connect geometry in the current workgroup.

Terminators will select all points used to terminate open geometry in the current workgroup.

Lines
There are three options to select Lines.

All Lines will select all lines in the current workgroup.

Feeds will select all lines designated as “Feed” in the current workgroup.

Rapids will select all “Rapid” lines in the current workgroup. See theModifymenu section of
this document for more information on Feed and Rapid geometry.

Curves

Selects all splines or curves in the current workgroup.

Dimensions

This will select all dimensioning annotationsmade in the current workgroup.

Text

Selects all textual annotationsmade in the current workgroup.

Sheets

Selects all sheets in theWorkspace and open Body Bag.

Solids

Selects all bodies in theWorkspace and Body Bag if it is open.

All Profiles

Any profile shapeswill be selected.
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Edges

The Edges itemwill select all edges of selected bodies and sheets that are in theWorkspace. Any
edge you do not want to select must bemanually deselected.

Faces From Selected Profiles

Faces that are bound by the current profile will be selected.

Walls From Selected Edges

Anywalls connected to selected edgeswill be selected.

Current CS

The Current CS item provides a quick way to select all geometry and bodies in the current coordinate
system. Geometry or bodies defined in coordinate systems other than the currently active CS will
not be selected.

By Depth

To select elements By Depth, enter values for From and To (in other words, depth values) to define
themaximumandminimumparameters for the selection. When the Select button is clicked any
element that lies within the range (wholly or partially) will be selected. If a section of connected
geometry falls within the selected range, only within-range elements will be selected. None of the
connection points or other elements outside of the range will be selected.

By Reference

To select an element By Reference, enter the Reference number that corresponds to the desired
selection. Reference numbers are assigned by the system to every geometric element created. They
can be viewed by turning on Labels from the Viewmenu. Tomake the selection, click the Select
button.

By Body Comment

To select (or deselect) bodies by comment, simply enter the search criteria in the By Comment dialog
and click on Select. This will select all bodies whose Comments field contains the search criteria.
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A search can be very specific, such as a name given to the body, or the searchmay be very simple,
such as selecting all bodies with the letter “s” in the comments. When Full Comment is selected, only
bodies whose comments are exactly the same aswhat you entered will be selected.WhenMatch
Case is selected, capitalization of words is taken into account: even if “rounded” was entered and a
solid or sheet contained “Rounded” as a comment, it would not be selected.

If the entry is left blank, all bodies with no comment will be selected.

By Body ID

To select a body using Select > By Body ID, enter an ID number that corresponds to the solid or sheet
you want to select. ID numbers are assigned by the system to each body that is created or imported,
and can be viewed by querying the properties of the body. For bodies in the Body Bag, if View >
Show Solid ID is in effect, the body ID is appended to the body name.

By Body Name

To select bodies (solids and sheets) By Body Name, you enter some data in theName box to specify
the selection. All bodies have names — either automatically generated (such as Sphere 35) or given
by the user. When Full name is selected, only bodies whose names exactlymatch the text entry will
be selected.WhenMatch case is selected, capitalization of words is taken into account.

Example: If you were to enter the text “round” into theName box, it would not match a body named
“Rounded” if either checkbox is selected.

Deselect Special

The items contained in this sub-menu will deselect any geometry or bodies of the chosen type. The
Deselect sub-menu items have the same criteria as the Select sub-menu (explained above).

Geometry Expert

Insert Row

This itemwill insert a blank row in the spreadsheet above the currently selected row.When an
inserted row contains the necessary information and is entered, the systemwill recalculate the
shape and attempt to incorporate the inserted feature into the existing shape, if possible.

Use Other Intersection

This itemwill toggle between Use Intersection #1 and Use Intersection #2 in themenu. This option
enables the user to select different intersections between concurrent features in the spreadsheet.
This option is available when the feature defined by the current row intersects the feature defined
by the following row in two places. This itemwill change the point of intersection selected in a
previous post targeting dialog to the other possible choice.
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Delete Row

This itemwill delete the selected row from the spreadsheet. As soon as the row is deleted, the
systemwill adjust the remaining shape tomaintain the appropriate connections, if possible.

Reverse All Rows

This item is only active when theGeometry Expert spreadsheet is open.When selected, it will
reverse the order of the rows in the spreadsheet which will change the direction of the shape as it is
loaded in Geometry Expert. This is useful when loading a shape that was imported or created using
the Free-FormCAD tools. When a shape that was not created using Geometry Expert is loaded
into the spreadsheet, the system decideswhether to go in a clockwise or counterclockwise direction
when placing the features into the spreadsheet. Shape direction has the potential to affect the angle
values of lines and the direction of arcs. There are timeswhen the systemwill load the shape in the
opposite direction than the one desired.When the shape has been loaded into the spreadsheet,
select the Reverse all rows item to reverse the order of features. This item is only available when the
spreadsheet contains feature rows.
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The View Menu

The Viewmenu provides access to commands that affect the display and how things are viewed.
This includes theWorkspace, itemswithin theWorkspace, geometry, solids, workgroups, and
coordinate systems.

• View Orientation and Control next

• “Explode/Coordinates” on page 67
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• “Visibility” on page 67

View Orientation and Control
Top Bottom

(Ctrl+E) Top view is the standard, default view of the XY plane inMill, ZX in Turning. Bottom is the
opposite view.

Front Rear

(Ctrl+F) This a view of the XZ plane, Rear is the opposite view.

Right Left

(Ctrl+G) This is a view of the positive YZ plane inMill, positive ZY in Turning. Left is the opposite
view.

Isometric Reverse Iso

(Ctrl+I) This is a “world” view. The part is drawn such that the part dimensions are all
foreshortened equally. Reverse Iso is the opposite view of the isometric part.

Home Reverse Home

(Ctrl+H) This is an option for Mill/Turn, Multi-TaskMachining, Advanced CS, SolidSurfacer, and
products that build on these products. HomeView is equivalent to the Top View for 2-axismill or
turning parts. For any part with multiple coordinate systems, HomeView rotates the view of the part
to a view normal (3D perpendicular) to the current coordinate system. The Home view always
displays the part with the positive depth axis projecting out of the screen. This has the effect of
showing the part rotated into the position it will be in when it ismachined. Reverse Home shows a
view of the negative side of the active CS.

Op Cutting Plane Reverse Op Cutting Plane

Click to highlight an operation, then select this option. The Cutting Plane of the operation is
displayed.

Unzoom

(Ctrl+U) Also known as no zoom. This sets the scale of the stock diagram to themaximum size that
displays the entire stock diagram. The actual size is based on the stock size and the current view.

Redraw

(Ctrl+R) This item refreshes the screen image allowing the user to get a better indication of what is
currently drawn on the screen. Geometry, toolpaths, or the rendered part image can be redrawn
using this item.

Previous View

(Ctrl+K) This item changes the current view to the last view that wasworked in.
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Zoom In Out

(Ctrl++) Increases/Decreases the scale of the view, enlarging/shrinking by 25% each time you
press Ctrl++.

Explode/Coordinates
Explode View with Preview

View each connected shape and solid with space separating it from the others, displayed from the
cameras perspective. An insert preview window is displayed. Hovering over any area in the
preview window will zoom themain view to that area.

Explode

As above but no preview window.

Mouse Position

2D location 3D location

TheMouse position dialogmay also be accessed from the geometry context menu. The top section
of the dialog allows the user to view the absolute two-dimensional (X and Y) or three-dimensional
(X, Y and Z) location of the cursor. As the cursor ismoved, the values are updated. The lower
section of the window displays the incremental distance between two selected points, the relative
distance between a selected point and the cursor and the angle of a straight line between two
selected points or a point and the cursor.

By selecting two points with themouse, theMouse Position dialog will display the distance between
the two chosen points as an incremental value. Each point selected will be confirmed by a red
marker on the ruler within the dialog.When one point is selected, the systemwill display the
distance (and angle) between the selected point and the cursor.

Visibility
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Labels

(Ctrl+L) If this item is active, labels will be drawn next to every geometry feature. Circles and arcs
will be labeled C#; Lines L#; Points P#, and Bezier splines (free-form curves) B#. The # is
determined by the order the points and featureswere created in.

Points

(Ctrl+J) If this item is on, all points (plain points, connectors, and terminators) will be shown.

Extend Lines

When this is active, all unconnected lineswill extend to the edge of the stock. If it is turned off, lines
will only extend to the features theywere created between.

Show Stock & Origin

If this option is turned on, the gray outline of the stock and the origin marker will be drawn.

Show Geometry

(Ctrl+[) When enabled, this redraws only points, lines, circles/arcs, and splines. It will draw
geometry over the rendered image of the part.

Show Hole Features

This toggles screen display of hole features. The top of the hole is shown as a cross. The bottom of
a blind hole is shownwith a line perpendicular to the hole axis.

Show Solids

If this is turned on, solids and sheets in the workspace will be displayed.

Show Dimensions

This toggles screen annotations on and off. Or, if themodel contains PMI (Product and
Manufacturing Information), it opens the pull-downmenu for the Show Dimensions Floating
Toolbar button, so that you can choose which items to show or hide.

Indicate Sheet Side

When enabled, the negative and positive sides of each sheet will be drawn in different colors.
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The Modify Menu
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TheModifymenu contains commands for changing the state of geometry and bodies. All options

under thismenu, except Move Part Origin, require geometry or a body to be selected before
their functions can be performed.

Several of the options havemultiple pictures, one for theMill module and one for the Turning
module. A few options treat Mill/Turn as a separate case. The functionality of each of the options is
identical for both theMill and Turningmodules; however, the dialogs differ slightly due to the
different axis designations.

This checkbox option is found in several of the functions accessed from theModifymenu. The
functions can be applied to entire workgroups aswell as to any selected features. This function is
accomplished by checking the Visible WGs checkbox and clicking Do It. Visible workgroups include
all workgroups that are displayed in theWorkspace, including background workgroups. The Reverse
Arc, Change CS (XYZ) and Change CS (HVD) items in theModifymenu do not have dialogs associated
with them. These three functions can also be applied to all items in VisibleWGs by selecting the
item from theWG List context menu, accessed by right-clicking theWorkgroup list.

• Transform

• Other Modify Commands

• Wrap/Stock

Transform
Force Depth/Radius

This selection sets the absolute Z value of all selected geometry to the Z value entered. This option
is unavailable when working in the Turningmodule and therefore the item is grayed out in the
menu.

Mirror

Mill Turning Mill/Turn
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This selection will move the selected geometry or bodies to the other side of the axis or axes
specified around an axis point entered in the text boxes. Clicking Do Itwill perform themirroring
function. This dialog can remain onscreen for further use while other functions are performed.

Absolute Rotate

 This selection will rotate selected geometry or bodies at an absolute angle around a specified point.
That is to say: The geometry will be rotated from an angle to another angle around the point
specified in the X and Y (in Mill) or Z and Xr (in Turning) text boxes. The angle of a geometric element
can be determined by interrogating the feature. Clicking Do Itwill perform the rotating function. This
dialog can remain onscreen for further use while other functions are performed.

2D Rotate

This selection will revolve or rotate the selected geometry or bodies around the point specified in
the X and Y (in Mill) or Z and Xr (in Turning) text boxes. The selected feature will be rotated by the
amount specified in the Angle text box, in either a CW (clockwise) or CCW (counterclockwise)
direction depending on the selectionmade. Clicking Do Itwill perform the rotating function. This
dialog can remain onscreen for further use while other functions are performed.
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Scale

This selection will change the size of the selected geometry by the amount specified. The value
typed in the Amount box is a ratio of one, one being full size. The inches >> mm ormm>> inches
buttonswill change the units of measurement accordingly. TheMill module has an Include Z option.
If the Include Z option is turned on, the Z values of the selected geometry will be included in the
scaling process. Include Z will not have an effect if the selected geometry is at Z0. Clicking Do Itwill
perform the scaling function. This dialog can remain onscreen for further use while other functions
are performed.

Absolute Translate

This selection will move the selected geometry or bodies from a position to a new position. This is
an absolutemove by a certain value. Clicking on Do Itwill perform the translating function. This
dialog can remain onscreen for further use while other functions are performed. Please note that
you do not need to use a value directly associated with the geometry or body. That is to say: You
canmove an element from its position to a new location based on relative numbers. For example, a
sphere centered at X20Y20 can bemoved to X40Y40 using a FromPos value of X0Y0 and a ToPos
value of X20Y20.
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Translate

This selection will move the selected geometry or bodies by the specified amount. Clicking Do Itwill
perform the translating function. This dialog can remain onscreen for further use while other
functions are performed.

Other Modify Commands
Duplicate
Duplicate And...

This itemwill Duplicate and perform the specified action. Force Depth, Mirror, 2d Rotate, Scale or
Translate the selection. First, the selected geometry will be duplicated. Then, depending on the
option selected, the selected geometry ismoved to one or more new locations based on the
number typed in the times text box.

Duplicate

(Ctrl+D) This selection copies the selected geometry or body to the same location. After this is
done, the next step is to move the duplicated item to another location, possibly using another item
under thismenu. Additionally, Duplicate is useful for creating an unconnected feature in the same
location as a currently connected feature.
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Geometry

Sort

This selection is only available in theMill module. It provides the user with amethod for sorting the
selection order of a selected group of points and unconnected circles. Once the points or circles are
sorted, the reference numbers (labels) are changed tomatch the new order. This is particularly
useful when performing drilling operations, because the system drills holes in the order they are
selected. There are three possible sorting options: S pattern (Zig Zag), Closest Hole next, and Reverse
pattern. The different options are described below.

S pattern (Zig Zag)
This option allows the user added control over how the points or circles will be selected.When
using S pattern, the system creates a rectangle around the selected group points like the picture
shown in the dialog. This rectangle is broken down into definite sections (like a grid) by creating
scan lines and grid squares. The grid will be created starting with the point in the farthest upper
right-hand corner contained in the selected rectangle.

The user designateswhat corner of the rectangle to select the first point by using the Start Corner
radio buttons. For example, selecting X+ Y+ will start the selection order in the upper right-hand
corner; X- Y+ in the upper left-hand corner, and so on. Selecting aMain Axis (X or Y) and
entering a Scan Height value will create scan lines, either horizontal or vertical, depending on the
main axis selection. TheMax. Gap value breaks up the scan lines into grid squares that can be
scanned for points. The Scan Height andMax. Gap values create the scan lines and squares
which break the area up in a grid-like fashion where all the selected points are contained in a
specific, defined area of the rectangle.

The systemwill select the point closest to the start corner (regardless of what scan line it is in) as
the first point, and then proceed to the next closest point in that section of the grid. If no other
points are contained in that area, the systemwill move to the next closest section and select the
next group of points. The system always looks at the scan line first and then looks across or
down the square for the next point. This continues until all selected points in the group are found
and labeled.
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Closest hole next
This option is fairly self explanatory. The system starts with the first point or circle selected and
then selects the point or circle that is closest. This process continues until all holes have been
selected. This option is useful when creating curves.

Reverse pattern
This option reverses the original selection order of the group of points or circles. The last point
that was selected is now labeled as the first point and so on.

Reverse Arc

(Ctrl+T) A circle can be fully connected either using the less than 180° arc or with the greater than
180° arc. The system automatically selects the less than 180°arc as the fully connected feature. If
the other arc is needed, select the connected arc and the Reverse Arc item. In other words, selecting
Reverse Arcwill tell the system to use the other side of the connected arc.

Toggle Feed Status

1. Start Point, Begin Rapid
2. Begin Feed
3. Begin Rapid

Toggle Feed Status allows the user to toggle the status of geometry from a Feed line to a Rapid line.
This is particularly useful in roughing operations as illustrated in theMill Tutorial wheremouse lines
are drawn, depths are changed and Feed or Rapid is designated.

This image shows a series of tool moves. The dashed lines indicate Rapidmoves and solid lines
indicate Feedmoves. Note that we are rapiding into the part. In the second image we have toggled
the lines fromRapid to Feed where the toolmoves down onto the part.

Toggle Wall/Air

This option toggles geometry between wall features (light blue) and air features (red). This is used
for pocketing, particularly for open sided pockets. Tools will not crosswall geometry but can cut
across air features. See theMill manual for more information.
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Segment Spline

An example of various spline segmentation settings.

Segmenting splinesmeans converting a smooth curve (a NURBS) into a series of line or arc
segments that approximate the shape of the curve. The features, or segments, may consist of lines
or arcs. When converting the spline to segments the Accuracymust be set. The Accuracy value is the
chord height used to designate how closely the segments will approximate the spline. The tighter
the accuracy, themore segments that will be created to approximate the spline.

Segmenting splines into Arcs is generally preferable over segmenting into Lines. Arcs will provide
smoother toolpath and lessG-code output.

The series of images illustrate the differences between segmenting a spline into lines versus arcs at
two different accuracy settings. As you can see, even a loose accuracywith arcs is smoother and
more accurate compared to the same accuracy used with lines.

Solid/Sheet

Shrinkage

The Shrinkage function is designed to be used when creatingmolds to compensate for shrinkage
factors encountered in themanufacturing process, compensating for the rate at which an injection
substance will shrink in amold cavity. The Shrinkage item allows users to perform uniform or axial
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reductions or enlargements on selected bodies. The Shrinkage range is -10% to 10%. A selected
body can be reduced or enlarged up to 10% of its original size.

Final Size = (100 - Shrinkage%) * Start Size /100

Toggle Sheet Side

The Toggle Sheet Side itemwill flip the inside and outside of a sheet. This item is useful when
solidifying sheets into bodies using theOffset solidify option. When sheets are converted into bodies
by offsetting, the offset must be calculated from one side of the sheet or the other. TheMax andMin
offset values are referenced from one side of the sheet. To offset the sheet from the other side,
select the sheet and then select the Toggle Sheet Side item.

CS

Change CS (XYZ)

When Change CS (XYZ) is used, all selected geometry will be assigned to the current coordinate
system. The geometry will stay in its same location in 3D space. It will change color to reflect the fact
that it is now in the current coordinate system. All selected arcs will be segmented (changed into
line segments), if the coordinate system they are being changed into uses a different plane than
their original coordinate system. If the Advanced CSmodule is not installed, this itemwill be grayed
out in themenu.

Change CS (HVD)

(Ctrl+\)When Change CS (HVD) is used, all selected geometry will be assigned to the current
coordinate system, and the HVD values of the geometry will be preserved. Thismeans that the
geometry will bemodified to be planar to the new CS location preserving the relative position. If the
Advanced CSmodule is not installed, this itemwill be grayed out in themenu.

Wrap/Stock
Unwrap Geometry

Selecting this item returns the display of wrapped geometry to flat geometry and takes dialogs out
of radial mode.

Wrap Geometry
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Selecting thismenu itemwill wrap all geometry in anyWrapped workgroup and switch Geometry
dialogs to radial mode. Geometry will be “wrapped” around the part at the radius or depth at which it
was defined. This item ismost useful in the Level 1 interface or as an alternative to theWrap
Geometry button found in the Toolbar of the Level 2 interface.

Shrink Wrap

(Ctrl+‘) When this item is selected, the window zoom size becomes just large enough to display
all geometry in the part (including visible and hidden workgroups). This is especially useful when
working with imported files.

Shrink Wrap Visible

(Ctrl+]) When this item is selected, the window zooms out or zooms in to display all visible
workspace elements without excess blank space. This is especially useful when working with part
files that include hidden ( ) workgroups or items in the Body Bag.

Move Part Origin

This function can save the trouble of recalculating the values of stock definition in the Document
Control dialog if the part’s origin needs to bemodified. This selection will move the part origin
relative to ALL the geometry in EVERY workgroup incrementally by the values typed in the
appropriate axis text box. In other words, the current location of X0, Y0, Z0 or Z0, X0 will change
incrementally by the values in this dialog and a new X0, Y0, Z0 will be established.When using
MTM you can choose which spindle will bemodified. Clicking on the Do It button will move the
origin. This dialog can remain onscreen for further use while other functions are performed.
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The Solids Menu

The Solidsmenu provides tools for verifying the validity of bodies and toolpath. Most of the items in
thismenu are system development tools that may be of little use to end users; however, on some
occasions, theymay be helpful as amethod of diagnosing issueswith solids.

Rebuild

This commandwill update any solids if changes have beenmade in the part’s history. This
command is also accessed by right-clicking on a body and is often used in conjunction with the
Recreate command. This function is not undoable.

Check Self-Intersect Loops
It is recommended that this option is left on for optimal 3D toolpath generation. Turning it off will not
save any system resources.

Tools sub-menu
The system’s arsenal of tools for diagnosing problematic solids can be found in thismenu. These
options aremiscellaneous tools to check and correct bodies aswell as report and output data. Each
item is described below under the category to which it belongs.

Validity Checks

These items do not fix any errors or problems youmay be experiencing, but are simply ameans to
determine whether the body you are using is valid or not. Thismay aid in troubleshooting any
problems you are experiencing with machining solids.
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Check Body Validity

When this item is selected, the system checks to ensure that all selected entities are valid. If a sheet
is not valid, it will be deselected once the check is complete, allowing the user to identify the
problem. An error message identifying the specific problemwill also be displayed for each invalid
entity.

Check Face Validity

This item runs a face validity check on the selected sheets. This function can also be performed by
clicking on the Face Check button in the Stitch Utils dialog, and is useful for when stitching has failed to
identify problem areas before attempting to stitch again.

Machining Face Check

This item checks the validity of selected faces to see if they can successfully bemachined.Machining
Face Check is only necessary when using theGen 2 Engine in surfacing operations. After validating
the face(s), the systemwill display amessage with information on the face(s) if the check passed or
an error message on each of the bad faces.

Remove Unneeded Topology

This commandwill inspect selected bodies or faces for any unneeded elements. If two items share
the same underlying surface, the bodywill be simplified. In this example we have a sphere and a
cuboid. The sphere (consisting of surfaces) shares a common underlying surface with another
sheet. The extra sheet will be removed from themodel when running this command. One edge of
the cuboid actually consists of two intersecting lines. The lineswill bemodified to be a single edge.

Simplify

This function attempts to convert NURBS surfaces into analytic surfaceswithin a given tolerance
amount. Often timeswhen surface files are imported, analytic surfaces are converted to NURBS;
this function will convert those NURBS back into analytic. The geometry of a body is simplified
wherever possible. A bodywill be defined by lines, circles, spheres, cubes, cylinders and tori
instead of B-splines.

Multi-Pass Stitch
Multi-Pass Stitch is a setting used with the Solidify function. WhenMulti-Pass Stitch is active, the
Solidify function will perform successive attempts to solidify sheets, starting at the tolerance
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specified. Sheets that do stitch at the specified setting will be stitched; any sheets that do not stitch
at that tolerance will be attempted at a looser tolerance. This will be attempted a third time at a still
looser tolerance. Multi-Pass Stitch is on by default.

Check Trimmed Surface Polyline
This item verifies the validity of trimmed surface polylines to ensure proper machining. Check
Trimmed Surf. Polyline is only necessary when using theGen 2 Engine in surfacing operations.

Check Trimmed Surface Edges
This item verifies the validity of trimmed surface edges to ensure proper machining. Check Trimmed
Surf. Edges is only necessary when using theGen 2 Engine in surfacing operations.

Check Op Gouges

The systemwill perform a check to see if a selected operation gouges a selected body. A gouge is
defined as being off by greater than 50% of themachining tolerance. This command only works
with ball endmill tools. If the operation gouges, two lineswill be drawn from the tool to show the
gouge. The first line runs from the tool center to the tip, and the second line runs to the point of the
gouge. This is illustrated in the following image.

Selected Op to Screen Points

This command creates points at the beginning and end of each feature of a selected operation. Any
type of operation on a solid may be used with this command. The Selected Op to Screen Points
command is useful for dimensioning toolpath. The image on the right shows a lace cut operation
composed of line segments. Note themany points created by Selected Op to Screen Points. If the lace
cut was defined by arcs or splines, the points would be different.
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Selected Op to Splines

This command creates a spline between sharp corners of any surfacing operation. For the Selected
Op to Splines command to work the curves dialogmust be open. The tolerance of the splines
generated from the toolpath is determined by the settings in the curves dialog. This image illustrates
splines generated from a lace cut operation defined by line segments.

Selected Op to Lightwork File
This command outputs the selected operation to a Lightwork file.

Selected Op to Text File
This commandwill output a text file of the toolpath. The text provides the position of all features. A
line feature includes the start and end X, Y and Z dimensions. Arcs include start and end point X, Y
and Z values, the arc’s radius and the arc’s direction.

GE to Text File
Geometry Expert must be open to use this function. Selecting this commandwill output the
Geometry Expert’s contents to a text file named GEDump.txt. The file is created on the Desktop.

Clear Bodies’ History

This option will remove the History of any selected bodies, making the body an atomic body. Undo
is not available for this.

The Features Menu
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The Featuresmenu provides access to two tools specifically for Hole features and two tools that help
youmanage user-defined features..

• HoleManager helps you to identify andmachine holes in solid models.

• HoleWizard quickly creates hole operations for you using the available tools and geometry.

• FeatureManager provides additional capabilities for managing attributes of type Feature and
elements that have been tagged with Feature attributes.

• AttributeManager allows you to create andmanage (view/sort/edit/etc.) data tags that attach
tomultiple elements; attributes can be of type Integer, Real, Text, Color, or Feature.

All options on thismenu are fully detailed in the Features guide. This guide is provided with the
installationmedia and is available for download from https://online.gibbscam.com.

Hole Wizard

TheHoleWizard automates the process of making holes. The HoleWizard canmake a single drill
hole or it canmake a pattern of tap holes usingmultiple tools on any number of holes. The Hole
Wizard does all of this in four easy steps and guides you through them.

Two of the HoleWizard steps

Hole Manager

HoleManager lets you identify Hole features in amodel, specifying geometry, creating groups, and
quickly defining the features. Fromwithin HoleManager, you can invoke HoleWizard (or use
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Auto Wiz) to invoke it multiple times) to create operations and the list of tools that are needed to
create holes.

HoleManager is intended for models with a large numbers of holes that are primarily solids.
However, even if you do not have any of the Solids options, you will find the sorting and grouping of
holes very useful.

Attribute Manager

AttributeManager presents attribute information in three panes:

l In the upper left, a two-column table lists the attributes defined for the current part. You can
sort by either column.When one or more attribute names are selected, corresponding
columns appear in the element list on the right.

l In the lower left, the Element Filter pane lets you specify what elements will appear in the
element list.

l On the right is a table of elements that meet the filter criteria. Each qualifying element
appears as a row of values. Cells on the far right show values for attribute whose names that
are currently selected.

Feature Manager

FeatureManager lists user-defined features in a table that displays their ID, Description, Type
(element-selection-based or attribute-comparison-based), Recreate flag, and Color:
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Tomodify a feature'sDescription, Recreate flag (for features based on attribute comparisons), or
Color, click or double-click the corresponding cell.

The Window Menu

TheWindowmenu provides control over windows and dialogs. It also provides access to part
summaries including workgroup data, the contents of the tool list, and a summary of the part’s
operations.

• Arrangement , next

• “ Tool, Process , Operation andWorkgroupManagers ” on page 88

Arrangement
Close All

Closes all open sub-menus.
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Cascade

Arranges dialogs so that all title bars are visible but dialog bodies overlap, as shown here:

Minimize All

When turned on, this command shrinks all dialogs to title bars only, tiling them along the bottom
edge of the workspace window, as shown here:

Managing a Large Number of Processes

If the base folder specified by Set Directory contains 500 or more sub[sub[...]]folders that contain
processes (or if the total number of processes contained exceeds 2500), the Processmenuwill not
display all folders (or all processes). Instead, the Processmenuwill display a new menu item: Process
Manager. Clicking this item opens a dialog that shows a collapsible hierarchy: the base folder, its
applicable subfolders, and so forth. This lets you navigate quickly and easily to the processe you

need to access. The top right corner of the ProcessManager dialog has a Browse button that
lets you reset the base folder for your processes.
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Tool, Process , Operation and
Workgroup Managers
Manager reports can be accessed from several places.

Managers are always available from theMainMenuWindow tab.

Right-click the Tool/Process/Operation/Workgroup List and select Manager ... from themenu.

OperationManager and Tool Manager are located in the Command Toolbar.

Viewing Data

In each of theManager interfaces, you can do any of the following:

• Choose which columns to display and in which order, by right-clicking the column heading and
choosing Customize Headers.

• Sort the display with a simple click on the required column header. You will note that the “sorted
by” is indicated by a triangle symbol in the header — pointing up is low-high, down indicates
high-low.

• Right-clicking anywhere in a row reveals amenuwhich enables you to:

- Sort the entire tile list, or find tiles andmove themwithin the list.

- Open the corresponding dialog.

- Isolate a subset of rows.

• Print or save the data using the icons provided in the header.

Dozens of data types are available. ToolManager can display up to 35 columns; ProcessManager,
up to 50; OperationManager, up to 79,WorkgroupManager up to 47. Balloon help will provide a
brief description when hovering over a column heading.
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1. Disallow editing (Default)
2. Allow editing of Operation
fields

3. Allow editing of Process
Fields

4. Print
5. Save

Editing Data

TheManager dialogs provide powerful editing capabilities. Clicking the Allow Editing buttons (shown
above) highlights all editable fields. You canmodify the value in an editable cell, or you can apply a
single value tomany selected items at once.

Multi-Selection

You can select multiple tiles to highlight multiple rows, and vice versa. However — important! — use
extreme caution when using Editmode, especially context menu item Apply Value to Selected...,
which copies the value from the cell under themouse location (the pointer cursor) into all
highlighted light-green cells in the same column, whether or not those cells are visible in the current
scroll region. The Apply Value ... choice is unavailable if any of the highlighted cells in the same
column are ineligible to receive the value of the cell that you right-clicked.)

Warning: In Edit mode, a single click can cause far-ranging global changes, and there is no Undo
capability.

To edit data:

1. Click Allow Editing of Data Fields. A warningmessage appears.
2. ClickOK. The fields you can edit highlight in green.
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3. Double-click the field you want to change and type the information. Or, if you are very
confident, you can right-click a cell whose value you want to copy to all editable cells and, on
the context menu, choose Apply value to selected operations This should not be used if you
have any doubt about the outcome.

/>

Multiple views

Themanager allowsmultiple views, and each view can be scrolled independently.

To split the manager grid:

l To create or reposition the horizontal split: Hover your cursor just left of the horizontal
scrollbar at the bottom.When the cursor changes to  or , click and drag it to the right
or left to create or reposition the horizontal splitter.

l To create or reposition the vertical split: Hover your cursor just above the vertical scrollbar on
the right. When the cursor changes to  or , click and drag it down or up to create or
reposition the vertical splitter.

Manager Context Menus
TheManager dialogs provide the following right-clickmenus:

l Title bar context menu
l Header row customize option



MainMenu

91

l Tool row context menu

Title Bar Context Menu

This is not available for theWorkgroupManager. To select items from the title bar context menu:
Right-click the title bar and select the item you want from themenu.

Tool Title Context Process Title Context Operation Title Context

Show Selected/All:
Displays selected or all items in theManager.

Multi-level Sort
Selecting theMulti-Level Sort… command opens a dialog where you can select up to four columns
you want to use as sort criteria. Check the Ascending checkbox to sort in ascending order,
unchecked will sort in descending order.

Clicking OK transfers the sorted order of the items in your Tool/OpsManager to the actual Tool and
Operation lists.

Important: Performing a sort changes the order of your operations. If you are not
careful you could tell the system to do something you do not want, such as tapping a
hole before the hole is drilled. The system does have a reminder to warn you that
performing a sort can be harmful but you should still be aware of the potential
consequences.
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Header Customization

Right-click the column title row and select Customize Headers. This option enables you to select
the columns to wish to show or hide in theManager reports and place them in the desired order.

Clicking a data type will provide a brief description of the item at the bottom of the screen. The item
is also highlighted in the visible columnswindow. Please note that data can only appear once in the
report.

• To show a hidden column: Under Available Columns, select a heading and click Add>>.

• To hide a visible column: Under Visible Columns, select a heading and click<<Remove.

• Tomove a visible column: Under Visible Columns, select a heading and click eitherMove Up
(to shift left) orMove Down (to shift right).

Report Row Context Menu

Tool Manager Process Manager Operation Manager Workgroup Manager
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To select items from the row context menu, right-click a detail row and select the item you want
from themenu.

Move To:

You use theMove To option tomove a tile to a specific position by
number or to move a tile to the last position in the list.

Find:

You use the Find option to locate a specific tile by number or jump to
the last tile. For operations, you can also search by tool number.

Sort:
Sorts all tools by Tool number in ascending order. For Operations, sorting reorganizes the
operations by tool number and creation order, from lowest to highest tool number. The system
examines all the operations and tries to group them by tool number tominimize the number of tool
changes. Any blank spaces in the Operations List are removed.

Operations created in a ProcessGroup (a group of processes tomachine the same geometry) are
sorted based on their order in the Process List when theywere created. For example, finishing
operations are not placed before the roughing operations in a Process List. You canmanually
reorganize operations by dragging them to the location you want in the Operations List. The order
of machining in the finished NC program is the same as in the Operations List. Therefore, the order
of tiles in the Operations List is very important. You can organize operations anytime during the
programming of the part.

Please be aware that sorting operations can be risky. For example, you could
potentially tell the system to tap a hole before it is drilled. Please be sure to review the
results of the sort to ensure you get the results you want.

Apply Value to Selected:
To apply a value to selected, select the rows you want to apply the value to, Then right-click the
cell containing the value you want to apply and select Apply Value to Selected.

Other options in the Operations context menu are described inmore detail in the Getting Started
guide.
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The Plug-Ins Menu

Plug-ins aremodular functions that are built onto the system to provide enhanced functionality. One
large advantage of plug-ins is that third parties can create software that integrateswith GibbsCAM.
Another strength is the rapid development of plug-ins, allowing clients’ needs to bemet quickly.
Each plug-in can interact with either geometry, solids, toolpath, the rendered part, or some
combination of these items. The actual contents of your Plug-Insmenu depends on your system and
specific plug-ins installed.

Two drop-downmenus provide access to plug-ins: most commonly used plug-ins are on the left,
and Legacy and Custom plug-ins are on the right. Also, you can pin your most-used Legacy plug-
ins to a pin-pad, or hide a pin-pad by clicking the pin icon at the top.

The layout and contents of the Plug-Insmenu can be customized using Plug-In Manager. This
interface allows you to place plug-ins into folders and subfolders (corresponding to submenus and
subsubmenus) and to globally activate or deactivate individual plug-ins and plug-in groups. You are
able to suppress or display plug-ins in any order and also group them into sub-menus. Changes
made by Plug-In Manager take effect the next time you start the system.
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For a full description of each plug-in provided by the software installation (including Operation
Modifiers that are implemented as plug-ins), see the Plug-Ins guide. This guide is provided with the
installationmedia and is available for download from https://online.gibbscam.com.

The Wire EDM Menu

If theWire EDMoption is installed and available to you, theWEDMmenu provides two options for
starting theWire EDMpackage:

• Launch EDM - Selected Geometry: StartsWire EDMusing only the geometry (2D lines, arcs,
circles, and points) in the current selection set.

• Launch EDM - All Visible Workgroups: StartsWire EDMusing all geometry in all visible
workgroups.

Complete reference information and instructions for using theWire-EDMpackage are provided in
theWire EDMguide. This guide is provided with the installationmedia and is available for download
from https://online.gibbscam.com.

The Macros Menu

TheMacrosmenu provides access tomacros that have been installed on your machine's global
data folder (such as C:\ProgramData\CAMBRIO\GibbsCAM\<version>). By default, onemacro,
Diamond Insert, is pre-installed to this folder. If you or your administrator have placed other macros
under this folder, theywill appear under theMacrosmenu.

Diamond Insert
The Diamond Insert macro is shipped as a sample, but not pre-configured as aMacrosmenu item. It
lets you create custom diamond-shaped inserts for turning tools. If it is not available on yourMacros
menu, follow the steps provided in “ Configuring theMacrosMenu” on page 96.
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The initial dialog of the Diamond Insert macro requires you to select a direction for the insert. For
example, here is the result of selecting Down Left as the setting for Insert Direction.

After youmake a choice for Insert Direction, clickOK. This opens a new dialog boxwhere you
define the angle type and specify the angles and radii of the diamond insert.

Configuring the Macros Menu

If you havemacros in a previous release of GibbsCAMand you have not yet
configured theMacrosmenu in your current release, you canmigrate the old
macros using theMigration Tool. If, instead, you have already configured your
currentMacrosmenu and you want to migrate oldmacros, see the instructions
provided in theMacroswiki.

TheMacrosmenu shows all macros that have been installed and configured to appear within the
menu. You can use Pathfinder to learn the location of the predeterminedMacros Folder — typically
under a global data folder like C:\ProgramData\CAMBRIO\GibbsCAM\<version>\Macros\ — but
you can use a different location if you prefer. You can add to and customize themenu entries by
selectingmenu item Configure to open theMacros dialog. A samplemacro, Diamond Insert, is
presupplied under theMacros folder, but theMacrosmenuwill display it only after it has been added
to the configuration.

TheMacros dialog lets you add and organizemacros:
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• To add amacro, simply select an empty field, enter the name as you want it to appear under the
Macrosmenu, enter the path and filename of the .mac file (either by using the Browse button, or
by pasting it from the text buffer, or by keying it in), and then click the Update button. Repeat as
needed.

• To add a separator line, create an entry whose "name" is a single hyphen ( - ). Separators help
you organize groups of macros.

• Tomove an entry above or below other entries, select it and then clickMove Up orMove Down.
Repeat as needed.

• Tomove an entry subordinate to its predecessor, select it and then clickMove In. Tomove an
entry one level higher in a stack of sub[sub]entries, select it and then clickMove Out.

• When you are donemaking changes, click theOK button. This closes the dialog and
immediately applies your changes to themenu structure under theMacrosmenu.
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The Help Menu

The Helpmenu contains options to help you use the system and provides additional information
about the application.

• Online Help, next

• Dynamic Help

• CAMBRIO

• About the Online Help

Online Help

Contents

Selecting this itemwill activate the system’s online help. A window will open in which you can
browse or search for information.
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For details, see About the Online Help.

Getting Started

Selecting this option will launch Adobe Reader and open the PDF version of Getting Started.

On Item

This item is the same as clicking theOn Item help button found on theGibbsCAMFloating

Toolbar. Once active, the cursor changes to the On ItemHelp cursor . Clicking on a dialog,
palette or window in GibbsCAMwill then open the online help to the section that is relevant to what
you clicked on. This is known as context-sensitive help.

14 PDFs

Selecting this option will launch Adobe Reader and open a “light” version of a PDF organizer that
references a few of the books in the GibbsCAMdocumentation set. (The full version of themaster
PDF is available from theGibbsCAM website, gibbscam.com, or when you install the complete
documentation set.)



MainMenu

100

Online Training

This opens a web browser to view the courses available fromCognusOnline Training. Courses
entitled “Whats New in GibbsCAM14”,” ProductionMilling for GibbsCAM14” and “Production
Milling/Turning for GibbsCAM2016 andOlder Versions” are available free of charge. A
subscription-based training program to learnmore advanced options such as 2.5D Solids, 3D
Machining andmore is available.

Whats New Presentation

Opens a short video displaying highlights of the newest features added in the latest GibbsCAM
version.

Dynamic Help

Balloons

This button toggles the on-screen help built into the system.When this item is checked, balloons
containing reference information will come up on the screen whenever themouse cursor ismoved
over an input box, command or other object (and not clicked). Use (Ctrl+B) to turn this option off.

Tooltips
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This option brings up the Tooltips dialog. Tooltips will show the name of a button or item themouse
is held over. The Tooltips dialog allows the user to set whether tooltips are shown and to set the
delay before tooltips are shown. The delay before a tooltip is displayed is set using the Tick Delay
option. Each “tick” is 1/60th of a second. The IDs item is not of any real use to end-users, as it will
display the identifying number of a dialog’s components, rather than a description. It is a
development tool.

The image below provides an example of a tooltip. Here the cursor is held over a button in the Solid
Modeling Dialog. The name of the button is displayed in a white box next to the hand cursor.

CAMBRIO

Check for Updates

Clicking this item causes the system to perform a one-time check for updated releases. If a later
version of GibbsCAM is available, amessage dialog appears.

You can configure whether or not to check for updates each timeGibbsCAM is started: File >
Preferences, Interface tab, checkbox Automatically Check for Updates on Startup.
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About GibbsCAM

The About dialog provides information about your GibbsCAM software aswell as phone numbers
and e-mail contacts if have questions or problems.

The About box displays your Gibbs ID, which can be copied and pasted directly from this dialog. If
applicable, your HASP key expiration is also displayed here.

About the Online Help

The system provides several navigation panes for working with online help:
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The icon on the Help toolbar activates the TOC pane, which
presents a hierarchical list of help topics organized into folders
and subfolders like a table of contents.

The icon on the Help toolbar activates the Index pane, which
presents an alphabetized list of keywords, each one linked to
one or more help topics.
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The icon on the Help toolbar activates the Search pane,
which uses a term that you enter to construct a list of all topics
that contain the term. The list is ranked by the number of times
the term occurs within the topic.

The icon on the Help toolbar activates the Favorites pane,
which lists searches and topics that you have previously
bookmarked.

To add a favorite topic, click (on the Help toolbar). To add a
favorite search, click (in the Search pane). To delete a
favorite, select the corresponding checkbox and then click
(in the Favorites pane).

Other useful tools in the Help toolbar include the following:

Add the current topic to your Favorites

Show or hide all navigation panes.

Expand all folders and subfolders.

Collapse all folders at the current level.

Print the current topic.

Find a text string within the current page.



MainMenu

105

Remove highlighting from search hits on the page.

Browse back to the topic last visited.

Browse forward to the topic next visited.

Stop loading the current topic.

Refresh the display of the current topic.

Jump to the home (root) topic of the online help system.

Jump to the previous topic in sequence.

Jump to the next topic in sequence.

Troubleshooting the Online Help System
Changing the Text Size

To temporarily increase the text size in online help, press [CTRL +].

To temporarily decrease text size, press [CTRL -].

Generally the size of the text in the Help window text is determined by the size of the default text set
for Windows.

Allowing Blocked Content

Depending upon the security settings for your operating system youmay receive an alert warning
you about Active Content. This is generated because of the installation of the JRE. You can easily
disable this warning and safely enable the JRE.

• Clicking on the warning brings up amenu. Select Allow Blocked Content...

• You will receive a Security
Warning. Click Yes to
continue.
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• To avoid this error message
in the future, open the
Internet Properties Control
Panel.

• Select the Advanced tab and
scroll down to the Security
section (it is at the bottom of
the list.)

• Select the Allow active
content to run in files onMy
Computer.

• Click Apply and then click
OK.
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Floating Toolbar

1. Show Geometry
2. Show Dimensions
3. Show Hole Features
4. Show Solids
5. Render/Wireframe
6. Indicate Sheet Side

7.WrapWGs
8. Show Stock & Origin
9. Show CS
10. Face Selection
11. Edge Selection
12. Toggle Profiler

13. Toggle Hidden-line Toolpath
14. Toolpath color mode
15. Toggle Pre-Selection Highlighting
16. Select Color Displaymode
17. Viewport ConfigurationManager
18. Unzoom
19. Get Help on Item

Show Geometry

When this button is active, all geometry in the currently selected coordinate system and workgroup
is shown in the drawing window.

Show Dimensions/Annotations

For amodel that has no PMI, when Show Dimensions is active, all dimensions in the currently
visible workgroups are shown in the workspace. If Show annotations is active, both dimensions and
annotations are shown.

Pull-down menu choices for PMI

When an imported GibbsCAMmodel contains PMI, you can hover over the
Dimensions dropdown button to open amenu of options relating to dimensions and PMI.
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PMI-related options under the Show Dimensions button; PMI Manager; andGibbsCAM
solid model with PMI displayed

Show Dimensions

When checked, non-PMI annotations are displayed.

Show PMI

When checked, PMI is displayed using themost recently used PMI view.

Manage PMI
Opens the PMI Manager dialog box.

PMI Manager displays all PMI items in a tree that is organized into the following categories:

Dimensions: Dimensioning information associated with the PMI, not with the GibbsCAM
model.

GeomTols: Geometric tolerancing information

Datums: Datum information for GD&T (geometric dimensions and tolerancing).

Notes: Annotations associated with the PMI, not with the GibbsCAMmodel.

Roughnesses: Information regarding surface texture and finish: smoothness, waviness,
and the like.
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Tree Controls for PMI Categories

- To expand a branch to see all items in a category, click the symbol.

- To collapse a branch and hide all items in a category, click the symbol.

Display Controls for PMI Categories and Items

- To display all items in a category, or to display a particular PMI itemwithin a category, select
the corresponding checkbox.

- To hide all items in a category, or to hide a particular PMI itemwithin a category, clear the
corresponding checkbox.

PMI Views

- If the importedmodel contains specific groupings of PMI items into named views, you can
click the Views button to list the defined views. Selecting a view rotates and re-centers the
workspace display and shows only those items of PMI associated with that named view.

- If youmake changes to the workspace display or the shown/hidden statuses of PMI items or
categories and items, the changes are saved in a special view named Custom.

Hide All PMI
Clears all checkboxes in PMI Manager, thus hiding all PMI.

Show all PMI
Selects all checkboxes in PMI Manager, thus showing all PMI.

Custom View
When checked, PMI is displayed using themost recent PMI custom view.

<viewname>
When checked, PMI is displayed using the named PMI view.

Show Holes

When this button is active, hole features are displayed in the workspace.

Holes are displayed in different colors, depending on the hole type. (See “ HoleManager” on
page 186.) In the Level 1 Interface, the hole is displayed as a dot. In the Level 2 Interface, the hole
feature is displayed and right-clicking the hole feature provides amenu as shown below.
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Activate CS From Hole

When clicked, GibbsCAMactivates the CS associated with the hole selected. It will be displayed on
the screen and highlighted in the CS list.

Reverse Hole Direction

This is not available for blind holes and will be greyed out.

Edit Hole Profile
Opens the Edit Hole Profile dialog.

Select Other
Enables clarification of the selection - if the point is clicked you can choose to select the Hole, Point,
or Solid. If the Hole Feature is clicked you can choose to select the Hole or Solid.

Show Solids

This button is very similar to the Show Geometry button, except that it affects bodies (that is, solids
and sheets). When turned on, all bodies are displayed in the workspace. If it is off, bodies are not
displayed. The display of bodies in the Body Bag is unaffected. This button is available with any of
the solids options — Solids Import, 2.5D Solids, and SolidSurfacer.

Render Solid Faces

This button has four states that control the rendering of bodies.

Render Solid is the default. It shows solids and sheets as normal rendered bodies. This
button is available with any of the solids options.
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Render Solid & Edges renders the bodies but shows the edges of the bodies.

Render Hidden Edges renders bodies as hidden wireframe objects — the “hidden” edges
are not shown.

Render Wireframe renders all solids and sheets aswireframe objects. This wireframe

state will be either edges or facets, depending on the File> Preferences > Display tab > Bodies
>Wire Drawing preference setting.

1. Render
Wireframe

2. Render Hidden
Edge

3. Render
Faces/Edges

4. Render Solid

Indicate Sheet Side/Annotations

This button is for use with sheets. It differentiates between the outside and inside of a sheet by
displaying them in different colors. The outside of the sheet will remain the standard blue that is
assigned to all sheets, while the inside will be displayed in red. The outside of a sheet is the side
fromwhich the positive direction of the surface normal is projected. The other side of the surface
normals are projected out from the inside of the sheet. The sheet side is important when performing
such functions as offsetting sheets or solidifying sheets using either the offset or extrude option.
This is due to the fact that sheets are offset or extruded in the positive direction of their surface
normal. It is possible to toggle the inside and outside of a sheet, using the Toggle Sheet Side item in
theModifymenu. This button is only available with the Solids Import or SolidSurfacer options.

Wrap WGs
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When selected, geometry in the current workgroup at a depth other than Depth 0 is wrapped
around a radius equal to the geometry’s depth. This button is available if Wrapped is enabled. The
Wrapped function provides continuousC-axis rotation onmilling operations, referred to as
wrapping.When theWrapWGs button is on, geometry is created and viewed radially, wrapped
around the part. Geometry can be defined using XZC coordinates, where X designates the radius
or diameter. In order to create and view wrapped geometry, a rotarymachinemust be selected and
theWorkgroupmust be defined asWrapped in theWG Info dialog. For more information see the
Polar & Cylindrical Milling section of theMill guide.

Show Stock & Origin

When this button is depressed (ON), the stock outline and origin are shown on the screen. This
button provides the same function as the Show Stock & Origin option in the Viewmenu.

Show CS

This button controls the visibility of coordinate systems and the plane that fills it. This button has four
states.

Hide CS Grid. The grid and plane are both hidden.

CS grid + plane, will show the CS grid and axismarkers for the current coordinate system.
The CS grid and plane will be drawn through the origin of the CS.

CS Plane will disable the grid but still show a shaded plane, representing the coordinate
system.

Grid only shows the grid but not the plane

Face Selection

When this button is depressed (ON), the system is in face selectionmode. Clicking a body (that is, a
solid or sheet) will select only the face and not the entire body. This button is available with any of
the solids options.

Edge Selection

When this button is depressed (ON), the edges of all solids and sheets in the workspace are
displayed. These edges can be selected. An edge is the curve or spline between two faces. In order
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to select edges for such functions as blending, geometry extraction, and body unstitching, youmust
be in Edge Selectionmode. Also, when using the stitching function, Edge Selectionmode is useful
for viewing the external edges of amodel. If an edge is double-clicked, the systemwill attempt to
select an entire loop that contains the selected edge. This edge selection will stop when it hasmore
than one good choice at a vertex. In some instances, it may take a few double-clicks on different
edges to select an entire loop, but it is still much faster than attempting to select edges individually.
This item is available with any of the solids packages.

Profiler

The Profiler is amoveable cross-section tool that can be toggled off or on in any of four different
modes.

The Profiler’smain use is to set machiningmarkers on a solid. The Profiler can also be used to
create geometry: Drag the profiler and release it; right-click a green geometry profile and, on the
context menu, choose Extract Geometry; when you click the dialog’sDo It button, the system creates
geometry for the selected geometry profile. This item is available with any of the solids packages.

To changemodes, hover over the dropdown arrow and choose from the list.

In Slice Plane
mode, the Profiler is
planar to the current
CS. To dynamically
display the part’s
cross-section
geometry, drag the
slicing plane up or
down along the
depth axis.

Sample part:
"Profiler_Slice-
Plane_Slice-
Silhouette.vnc"



Floating Toolbar

114

In Slice Spun Body
mode, the Profiler is
planar to the current
CS, and slices the
outline of the body
that would result
from spinning all
elements around
the rotary axis.

Sample part:
"Profiler_Slice-
SpunBody_Slice-
Cylinder.vnc"

In Slice Silhouette
mode, the Profiler is
planar to the current
CS, and displays
the outline of the
“shadow” cast by all
bodies from rays of
light normal to the
plane and shining
down on it. Each
body (even amulti-
lump body) casts a
single shadow with
a single outline.
Multiple bodies cast
separate shadows
with possibly
overlapping
outlines.

Sample part:
"Profiler_Slice-
Plane_Slice-
Silhouette.vnc"
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In Slice Cylinder
mode, the Profiler is
cylindrical
perpendicular to the
current CS. To
radially expand or
contract, drag the
slicing cylinder
outwards or
inwards.

Sample part:
"Profiler_Slice-
SpunBody_Slice-
Cylinder.vnc"

Profiler modes: See sample parts "Profiler_Slice-Plane_Slice-Silhouette.vnc" and
"Profiler_Slice-SpunBody_Slice-Cylinder.vnc"

Hidden-Line Toolpath

This is amode for displaying the toolpath with hidden-line removal activated.When on, toolpath that
lies behind solid objects is not shown.

Toolpath color Mode
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In addition to the standard redGibbsCAM toolpath color, Toolpath can be displayed with the
Operation numbers, Tool numbers or Feedrate highlighted in user-editable colors.

Gibbs Toolpath Color Mode

Gibbs TP Mode is the toolpath display used in previous versions of GibbsCAM:

• Interop and entry/exit moves are all in one color. (default: white)

• Opmoves are all in another color. (default: orange)

• Rapidmoves are all in the same color as feedmoves, but drawnwith dashes.

Op Number Toolpath Color
Mode
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Op# TP Mode is useful for multiple operations, so you can see which ops create which toolpath:

• Interop and entry/exit moves are all in one color. (default: white)

• The toolpath for each operation is drawn in that operation’s “Op Color” — that is, the same color
displayed whenOp Sim is in OpColor mode.

• Rapidmoves are in the same color as feedmoves, but drawnwith dashes.

Tool Number Toolpath Color
Mode

Tool# TP Mode lets you see which tools create which toolpath:

• The toolpath for each op is drawn in that op’s “Tool Color” — the color displayed whenOp Sim is
in Tool Color mode.

• Interop and entry/exit moves are also in the Tool color, so you can easily identify tool changes.

• Rapidmoves are in the same color as feedmoves, but drawnwith dashes.
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Feedrate Toolpath Color Mode

Feedrate TP Mode lets you see whenmoves vary in speed so you can identify fast feedmoves that
might be dangerous:

• The toolpath for each operation is drawn in a color that ranges from cool “slow feed” to hot
“fast feed”

• Entry/exit moves are drawn in the same color as an op toolpathmove at that feedrate.

• Interopmoves are in Gibbs color (default: white); interop feed is solid, and interop rapid is
dashed.

• Intra-operation rapids are drawn in a dashed red.

Pre-Selection Highlighting

Thismode highlights objects on the display as if theywere selected whenever the cursor passes
over them. The preselection face and edge colors, halo transparency, and thickness can all be set
by the user in preferences on the Color Tab.

Color Mode

Thismode determines the color mode in effect for the workspace if Feature Color or one or more
User Colors have been defined. Hover over the dropdown button to display all modes that can be
selected.

Viewport Manager
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This button activates the Viewport ConfigurationManager, which lets you to switch between
viewsets, create a new viewset, bring up the view manager, indicate a default view for a viewset, or
lock the attributes of a viewset.

The systemmaintains three default internal viewsets, each of whichmaintains its own set of
viewports (panes and windows). These internal viewsets are tied to a particular part. To switch
between viewsets, simply hover over the dropdown arrow and click the name of the desired
viewset.

Right-clicking the title bar of the Viewsets window, or right-clicking the name of a viewset, displays
a context menu. From thismenu you can create a new viewset, delete a viewset, access View
Manager, or lock the attribute set.

If Attribute Set Lock is checked, any changesmade (turning on edge selection, render wireframe,
etc.) will affect ALL viewports, active or inactive. If Attribute Set Lock is unchecked, changeswill
affect only the active viewport.

Additionally, you can define if a given viewset will default to Part,Op/Tool Sim, orMachine Sim. These
checkmarks can be active in only one viewset at a time. They specify which viewset will be used for
eachGibbsCAMmode (Part,Op/Tool Sim, orMachine Sim).

The Viewsets context menu includes an option to access View Manager, which displays the Views
dialog box.
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The pull-down button lets you select one of the eight pre-defined pane layouts. Panes are
always visible. Each pane or window will always show in part mode, and display the part.

View Manager also allows you to define the look of each viewport. Each viewport can haveMachine
Sim andOp/Tool Sim toggled on or off. If theMachine Sim and/or Op/Tool Sim options are checked, the
pane or window will also show a rendering session (Machine Sim or Op/Tool Sim) when using these
modes.

Windows behave slightly differently from panes here, as they can be toggled to be seen or unseen
by clicking on the eye icon.

Unzoom

Returns screen to full visibility.

Help on Item

This item is used to activate context-sensitive online help. When you select this item, the cursor
switches to the Help cursor. When you click on an item in the interface with the Help cursor, the
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Online Help opens to display the help topic for that the selected item. As soon as you click on an
item, the cursor switches back to its normal state.
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Commands toolbar
This area of the User Interface is highly customizable: individual commands can be added or
removed, and individual command groups can bemoved out of the toolbar to the bottom or sides of
the workspace — whatever suits your needs. (See Customizing the User Interface)

The standard display is as shown below:

The toolbar can beminimized by using the small box controls situated on the left of
themenu. (In the example below the command text has also been removed).

The contents of the default toolbars change according to the current Interface Level set in the
File>Preferences>Interface Tab.

Level 1 Interface Level 2 Interface
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Level 1 Interface Level 2 Interface

Actions Command Toolbar Group

Document Control Dialog
Displays the Document control dialog where themajor settings for the part are specified. For more
information, see the section on "Setting up a part" in the Getting StartedMill and Lathe guides.
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View Control Palette
The View Control palette lets you easily change the current view of the part. The eight buttons
around the outside of this circular palette provide quick access to standard views and lets you
redraw or unzoom. Holding the Alt key and clicking one of the buttons shows the opposite view.
The trackball ismoveable; drag its edge tomove the trackball around the workspace.

Click and hold the center ball with themouse and it will operates like a trackball. If you use the left
mouse button, the part moves only when you release the button. Use the right mouse button and
the part moves dynamically. The “T” always identifies the Top surface of the part.

The track ball has four small solid black triangles around it, inside the ring of buttons (located at
12:00, 3:00, 6:00, and 9:00). These are called axis “handles”. Drag any of these handles in a
circular motion for Z axis view change. Or drag the top/bottom triangle vertically (up and down) to
rotate the part about the Y axis. The left/right handle dragged horizontally (left and right) rotates the
part about the X axis.

If your mouse is equipped with a scrollwheel, you can click anywhere in the workspace and drag
themouse to dynamicallymove the stock and geometry. Scrolling with the scrollwheel will also
make the part display larger or smaller.
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Keyboard control

Rotating
Rotating the part is controlled by pressing the Shift key and the appropriate arrow keys on your
keyboard. Rotating can also be accomplished using Ctrl+click-dragging the third button of the
mouse (producing the same results as rotating the part using the rectangle in the track ball).

This key combination rotates the part upward by about 10%; southmoves toward you
and north recedes.

This key combination rotates the part downward by about 10%; north moves toward you
and south recedes.

This key combination rotates the part to the right by about 10%; west moves toward you
and east recedes.

This key combination rotates the part to the left by about 10%; east moves toward you
and east recedes.

The point of rotation depends on the current view.Whatever intersects with a ray that
projects from the center of the GibbsCAMwindow is what the view rotates about. If the
ray intersects with a solid, the part rotates about the center of the intersection. If the ray
intersects with the part stock, the rotation is about the center of that intersection. If the
stock is not in the center of the window, the rotation is about the intersection of two
planes that define the stock boundary and the ray.

Panning
Panning is controlled by pressing the Ctrl key and the appropriate arrow keys on your keyboard.
Panning can also be accomplished by a Ctrl+Drag.

 This key combinationmoves the part up by about 10% of the screen.

 This key combinationmoves the part down by about 10% of the screen.

 This key combinationmoves the part to the right by about 10% of the screen.

 This key combinationmoves the part to the left by about 10% of the screen.

Zooming

Mouse. You can drag amarquee around the region to zoom in. Additionally, if your mouse is
equipped with a scrollwheel, each turn of the scrollwheel is equivalent to a 10% zoom in or out. For
scrollwheel zoom actions, the center of the zoom is determined by an interface preference that you
can set using File > Preferences > Interface: If the Zoom to Mouse Cursor checkbox is selected, the
zoom center is the cursor; otherwise, the zoom center is the window center.

Keyboard. You can zoom in and out of the part is by using the Ctrl keywith the + or – keys.
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 This key combination zooms in on the part by about 10%.

 This key combination zooms out from the part by about 10%.

CS List
Clicking this button activates the Coordinate Systems dialog. If you click on the small arrow in the
bottom corner of the icon, a selectable list of all the current CS's is displayed. Coordinate systems
are used for 3D geometry creation, rotary part orientation for machining, multiple work fixture
offsets, and as a basis for solid modeling. For more information, see the "Coordinate Systems"
section in the Getting Started guide.

CS Palette

This activates the Coordinate SystemPalette. For more information on Coordinate Systems see
the Advanced CS guide.

Workgroup

Clicking this button activates theWorkgroup dialog. If you click on the small arrow in the bottom
corner of the icon, a selectable list of all the currentWorkgroups is displayed.Workgroups are
separate layers used to separate different groups of geometry, including custom stock. For more
information, see the "Workgroups" section in the Getting Started guide.
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Body Bag

This opens the Body Bag. The Body Bag is used to organize theWorkspace by storing bodies
during part creation. For more information on the Body Bag, see the "About the Body Bag" section
of the SolidSurfacer or 2.5D Solids guides.

CAD Command Toolbar

Geometry Palette
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Accesses themain Geometry creation palette. For more information, see theGeometry Creation
guide.

Dimension Palette

This opens the Dimensioning Palette. For more information, see the "Dimensioning" section in the
Geometry Creation guide.

Surface Modeling

This activates the SurfaceModeling Palette. You use the SurfaceModeling palette to perform
sheet, or surface, modeling. For more information on SurfaceModeling see the "SurfaceModeling"
section of the SolidSurfacer or 2.5D Solids guides.

Solid Modeling

This activates themain Solid Modeling palette. For more information on Solid Modeling see the
"Solid Modeling" section of the SolidSurfacer or 2.5D Solids guides.
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CAM Command Toolbar

Tools

This button activates the Tool List on the top left of the screen, containing the tiles that you use to
define tools. For more information see "Tool Creation" in the Getting Started guide.

CAM

TheMachining button activates the Process andOperations lists and theMachining palette for the
type of machine specified in the Document control dialog. You canmove theMachining palette to
any location on the screen. This palette contains Function tiles and buttons. The Function tiles are
moveable objects that you can drag to the Process List to create operations.

LatheMachining Palette Mill Machining Palette

Note: The processes that appear on the palette depend on which product options are licensed and
active. They also vary according to theMachine Definition Document (MDD) associated with the
Machine type currently specified in the Document Control dialog.

The Select Process Type dialog can be customized. See the Process dialogs section in theMill and
LatheGuides.
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Tile Lists

When you click the CAMbutton, both the Process andOperation Tile lists are displayed. The
Processes and Operations buttonswill toggle the individual lists on and off.

Cut Part Rendering and Simulation

For more information see the section on Simulation Cut Part Rendering and Simulation:

Program Error Checker

When you open a pre-V12 *.vnc file in V12 or later for the first time, an icon appears on
theMain Palette:

To run ProgramError Check, click the button. The systemwill then test the current *.vnc file for
errors and incompatibilities and displays any problems found, or else themessage “All Checks
Passed.”

Post Processor dialog
The Post Processor button in the Command Toolbar becomes active oncemachining operations
have been created in a file. Clicking the Post Processor command in the CAM commandmenuwill
display the Post Processor dialog. This dialog allows you to select a Post Processor, an .NCF

Program name, and the format of the output. The Document Control dialog in the Actions
command box is used to set upMultiple Parts or TMS, if available.
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For details, seeOptions tab

1. Post Processor Selection
2. ProgramName
3. Communications
4. TextWindow

For details, seeWorkfixtures tab

The text file will be saved under the file name entered and is displayed to the right of the Program

Name button . If a file with that name already exists the systemwill ask if you want to replace
the existing file. If yes, clicking the Process button will erase the old file and replace it with the new
one. To view the text file as it processes, click the TextWindow button.When this button is
depressed, a window will appear that displays the posted text file as it is created. The programwill
scroll by in the window as it is being generated. The Pause button allows the user to stop the
scrolling of the output as it is being processed. The Print button will be available after the program
file is finished processing. Clicking the Process button generates the NC program for the file
currently open.

Before posted output can be generated, the post processor and program file namemust be
specified.
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To select the post processor, click the Post Selection button. AnOpen dialog will appear that
allows the user to access the directory or folder where the post processors are stored in the system.

The actual file names of the post processors are different depending on the operating system.
However, when selecting a post processor, the full name (including the Control andMachine) will
be displayed in the Open dialog.

When a file is post processed, a text file is created with the
extension specified in the Post text box in the File >
Preferences > Import/Export> File Extensions dialog. By
default this extension is set to *.NCF.

A file can be post processedmultiple times and saved with different *.NCF file names. If changes
aremade to the part file, it must be post processed again in order to incorporate the changes into
the posted output. As a default, the text file uses the part file namewith an *.NCF extension (e.g.
EXAMPLE1.NCF). This file name can be changed by clicking the ProgramName button and
entering a new name.

Options tab

The items in the first tab of the Post Processor dialog change the format and content of the finished
output. Each item can react differently with different post processors. Below is a description of the
effect theywill have with most post processors.

Selected Ops
Checking this itemwill cause the output to only include operations that are currently selected in
the Operations list. Items that are unselected will not be output.

This is not recommended for MTMpart files or any part containing rotary axis rotations. Instead,
post-process all operations together, to avoid possible large differences between posted output
of operations using Selected Ops and the same operationswhen posted together with others.
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Starting Program Number
This is the number of the program as it will appear in the control. It is also the starting number for
all sub-programs. If the Starting ProgramNumber is one, the first sub-programwill be two, the
second three, etc.

Sequence from
This is the starting number for the block numbers or “N” numbers. The by box determines the
increment.

Minimize Line (N) Numbers
If this option is turned on, the post processor will only output block numbers on tool change
positions.

Insert Comments
This option will output information about each operation and tool used aswell as file length. If
any additional comments have been entered by the user about tools or operations, theywill be
output aswell.

Insert Optional Stops at Tool Changes
If this option is on, the software will output amachine operator selectable program stop at every
tool change. This is generally used as an aid to the setupman.

Minimize Sub Use
When this option is checked the post processor will prefer longhand output when possible.

Workfixtures tab

Items in the second tab of the Post Processor dialog let you do the following.

• Distinguish at a glance a part station from amulti-part part instance, with markers for whether
theWFO ismanually changed, the op is shifted from theWFOorigin, op oriented differently
from theWFOdefinition, or any combination, as shown in this table.

No shift, same
orientation

Op shifted
fromWFO

Op oriented
differently
fromWFO

Shifted
and
oriented

Part Station

Multi-Part

(marker: manual change)

Part Station, manually changed

Multi-Part, manually changed



Commands toolbar

135

• Assign aWFOper op rather than per CS (includingmulti-part instances).

• See theWFO list before you post.

• Tell the system how to handle caseswhere aWFOdoes not match a CS.

If your post is from before GibbsCAM12, the interface simply lists CS’s andWFOs.

Summaries Command Toolbar

MTM Command Toolbar

Sync Control
This button activates the sync dialog if your part usesmultiple spindle operation. It displays
operation tiles sized according to their individual run-times in the order in which theywill be
executed. All other times the option will be greyed out. For more information on SyncDialogs see
theMTMguide.
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Part Stations
This button activates the Part Station list if your part containsmultiple spindles. It is unavailable on
parts with only one part station. For more information on part stations (spindles), see theMTM
guide.
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Cut Part Rendering and Simulation
For Simulation, the rendered image is anOpenGL-based 3D part capable of zooming, panning and
rotating without restarting the render. The last-used render type becomes the active button in the
Floating Toolbar.

Op Simulation display is part-centric toolpath rendering, showing the part with material cut away
by the operations.

Tool Simulation shows toolpathmovement on the stockwithout anymaterial removal, displaying
inter-opmoves as dashed lines. The use of transparent stock display is recommended. In Tool Sim
mode, the Render Control has two additional sliders. Aswith other render modes, the first slider
(from top to bottom) controls rendering speed. The second slider moves the tool back and forth
through the render processwith a fairly coarse granularity. The third slider provides amuch finer
granularity of control. The Show Toolpath options control the display of the toolpath.

Machine Simulation can include an actualmachinemodel. To useMachineMode amachine file
will need to be selected using the LoadMachine option in the Render Control menu. However, if
you do not haveMachine Sim as a part of your license, you cannot load amachine simmodel. If this
is the case, machine simwill create a temporary
machine kinematicmodel (no visible
components) based on theMDD, and will do the
simulation with that. In Machinemode to aid in
the visualization of spindles on turningmachines,
the spindle will rotate while cutting during any
lathe turning operation. This rotation is only to
assist in showing the direction of rotation.

Rapid Sim rendering is only available for Milling operations and is a very quick rendering
method.

Legacy CPR is often faster to render, but if you change the view, the rendering restarts.

Simulation, in anymode, will show all of the part instances in a TMSmulti-part setup, whereas
LegacyCPR only shows the single part as programmed in the VNC file. Youmay find that when
checking your part file you use several or all of the rendering types, depending on your needs.

All operations are rendered in their current order. Selected operations render in shades of yellow,
and all others render in shades of grey. Shades of red appear when non-cutting tool surfaces or
rapidmoves hit thematerial. Selected tools appear in shades of yellow. Deselected tools appear in
shades of grey. Smaller pictures render faster and use less computer memory.

l Cut Part Rendering and Simulation Options
l “             PlaybackControls ” on page 139
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l “CPR/Rendering Visibility Controls” on page 141
l “Simulation Control Icons” on page 144
l “Simulation Context Menus” on page 151
l “ Settings for Op Sim, Tool Sim, andMachine Sim ” on page 25

Cut Part Rendering and Simulation Options

Hovering over the icon on the Command Toolbar, provides a dropdownmenu for selecting
one of the fivemethods of Rendering/Simulation. Click to select the required option. The last-
selected rendering type remains in effect.
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Playback Controls
The playback controls shown below are common to all Simulation palettes.

1. Current Display
2. Rewind
3. Stop
4. Step Forward
5. Play
6. Next Operation
7. Record (not LegacyCPR)

8. Speed control
Note: If you click the Stop or Step Forward button to pause the rendering, and then close and
redisplay the Render Control palette, rendering pauses at the same location. The system
rememberswhere you pause the rendering. Click the Play button to continue rendering.

Current Display
This box displays the number of the current operation being rendered or the current runtime.

Rewind
Click this button to return playback to the first operation.

Stop
Click this button to pause rendering.

Step Forward
Click this button to render the next feature of the current operation, and then pause.

Play
Click the Play button to render the part from the current feature of the current operation in the
Current Display box. Rendering continues until you click another button or the last feature of the last
operation renders. The Stop and Step Forward buttons pause the rendering. If you click the Play
button during rendering, the rendering pauses. TheNext Operation and Rewind buttons change the
current operation being rendered, but do not stop the rendering process.When the last feature of
the last operation is complete, rendering stops. If rendering is paused, you can click the Play button
to resume.

Next Operation
If rendering is in progress, clickingNext Operation finishes rendering the current feature, skips the
remaining features for that operation, and continues rendering the next operation. If rendering is
paused, clickingNext Operation advances the operation number in the Current Display box to the
next operation. Click the Play button to continue rendering.

Speed Control
Shows the current location of the Speed Control slider. The Speed Control slider sets the speed of
rendering. You drag the speed control slider to the left to slow the rendering speed or to the right to
increase the rendering speed. You can drag the slider while rendering is in progress and the
rendering speed adjusts accordingly.
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Record Video

For all renderingmodes except LegacyCPR, an additional red button is provided. Clicking it opens
a dialog that lets you save the current simulation as a video file. The output video can then be played
and viewed independently of GibbsCAM.

Output File
You can designate the path and filename of the output file.

Record
Click this button to start recording theMachine Simulation video.

Encoder
From the pull-down list, you can choose one of the following video encoders:

- H.264 Video

- Windows Media Video 7

- Windows Media Video 8

- Windows Media Video 9

- SMPTE 421MVideo

Frame Rate
Set the speed of the output video, in terms of how many frames to capture per second.

Video Dimensions
Set the width and height of the output video, either by entering the number of pixels or by using
the current window view size.

Simulation Legacy CPR Rapid CPR

1. Tool Visibility Control
2. Stock Visibility Control
3. Fixture Visibility Control
4. Lathe StockCutaway

5. OverlayGeometry
6. Show Rapid Tool
7. Show Tool Holders
8. Show Machine

9. Run time or Number of
Operation Display

10.Active Flow Number (For
MTMmachines)
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CPR/Rendering Visibility Controls
Tool Visibility Control
(Available for Operation, Tool, Machine Simulation, and LegacyCPR)

Aswith standard rendering, the hidden tool produces the fastest rendering; the solid tool is the
slowest of the options.

/ Invisible Tool:

If this button is selected, the tools do not appear during the rendering process, although thematerial
as a result of the tools cutting is removed (see example). Radii render more smoothly, and the part
renders faster with this choice selected.

/ Transparent Tool:

If this button is selected, transparent tools appear during the rendering process.

/ Visible Tool:

Select this button to display opaque tools during the rendering process.

Invisible Tool Transparent Tool Visible Tool

Stock Visibility Control
(Available for Operation, Tool andMachine Simulation and Rapid CPR)

For Rendering, stock can either be displayed as Translucent or Solid .
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Translucent Stock Solid Stock

Fixture Visibility Control
(Available for Operation, Tool andMachine Simulation and Rapid CPR)

For Rendering, fixtures can either be displayed as Translucent or Solid .

Translucent Fixture Solid Fixture

Lathe Stock Cutaway
(Available for Operation, Tool, Machine Simulation and LegacyCPR)

When rendering parts in the Turning, Mill/Turn, or Multi-TaskMachiningmodules, there are three

cutaway states for the stock cut part rendering. The three cutaway states are: No cutaway;
1/4 cutaway; and 1/2 cutaway.
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No cutaway 1/4 Cutaway 1/2 Cutaway

Overlay Geometry
(Available for all rendering options)

This option hides / showsworkgroup geometry while rendering the part.

Turning: NoGeometry Turning Geometry Mill: NoGeometry Mill Geometry

Show Rapid Tool
(Available for Operation, Tool andMachine Simulation)
The tool is rendered in a different color to show when it is Rapiding when this option is enabled.

Show Tool Holders
(Available for Operation, Tool, Machine Simulation and LegacyCPR)

No Toolholder Show Toolholder
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Show Machine
This option is only available in Machine SimRendering.

Run time or Number of Operation Display
(Available for all renderingmodes)

This displays the current run time or Operation number. If the rendering is stopped, the display is
the time it was stopped or the number of the previous operation. A value of zeromeans that
rendering has not yet begun.

Available on theMachine andOperation Rendering, the central "home" button, when clicked,
aligns the active Flow cutting plane to the home view.

Active Flow Number
The second dropdown box, on the right hand side, available for all Renderingmodes except
Legacy, is to select the active flow display.

Simulation Control Icons
TheRapid, Part, Tool andMachine Simulation palettes have various control options. To select an
option, click on the icon. In many cases, more than one icon can be selected at once.

Stops

(Available for Rapid, Operation, Tool andMachine Simulation)
Selecting this command allows you to set a point before which the rendering should stop. Use the
checkbox to add/deselect options. Rendering will stop after completion of the condition before the
number specified in the dialog.

Three stop options appear on the initial page. Select a stop using the checkbox, then double-click
the option to input conditions. All options except for "Stop at part Load/Unload", provide a window to
input specific operation/tool numbers, times, and so forth. When a stop is active it is highlighted with
a red box as shown below. If multiple stops have been set, use the play button to go to the next stop.

1. Stop Dropdownmenu
2. Delete Selected Stops 
3. Delete all Stops
4. Enable/Disable
selected stops
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Additional stop options can be chosen from the dropdownmenu. Scroll down themenu and select
the desired option, then input required values in the dialog window. The Stop at Script Condition
option has a right-clickmenu within the input window, providing the opportunity to input more
specific conditions. The Validate button will ensure there are no script parsing errors.

Stop at Script Condition Options

Tool motion on target body (Available for Operation and Machine Simulation)

This option provides a non-cutting simulation of the tool motion, like the simulation in Tool Sim
Rendering. Selecting this option will increase the speed of the simulation, where the display of
material removal is not as important as being able to see what the tool is doing.

Op Color Mode (Available for Rapid, Operation and Machine Simulation)

This option lets you use color to enhance the functionality of
CPR and Simulation. The corresponding options sub‐dialog
has three color modes: Cut Color (the default behavior,
matching earlier versions of the software), Tool Number, and
Op Number. The color of the remainingmaterial changeswith
each operation or tool. In this way, you can see what areas of
the part weremachined by each operation, tool, or selected
op. The color palette is generated automatically to create a set
of colors that are readily distinguishable from one another.
Double-clicking a color allows you to change it.
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Example of Cut Color, Tool Number, andOpNumber use

Collision Checking

(Available for Operation andMachine Simulation)

This option enables checking of collision events. The result of a collision event is controlled by
setting the Collisions/Limits parameters; for details, see Settings for Op Sim, Tool Sim, andMachine
Sim . The tolerances for collision detection are set in the Preferences. If the Collisions/Limits is set to
“Log To Display”, then a report detailing any “collisions” is generated. The report, which includes
when the collision occurs (Time), the XYZ value of the collision (Location), the operation, and the
tool, can be saved out as a text file. Additionally, the Prim 1 section details whether a Tool or Holder
was involved. The Prim 2 section reports whether the collision waswith Stock or a Fixture. Using this
option will slow down rendering speed.

Please note that to fully report gouges the target must be completely visualized. To do this, ensure
that Stock Transparency is set to Translucent.

Program error checking

(Available for Rapid, Operation andMachine Simulation)
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This setting checks for any axismotion that is beyond the limits set in anymachine component. If an
axis limit is exceeded, a collision event is generated in the sameway that it is generated when two
components collide. The result of an axis limit exceeded event is controlled by the Collisions/Limits
settings in the Simulation Settings dialog.

Please note that a Program error message will be displayed if axes are not properly set up or are
missing inMachineManager, even if this option is not enabled.

Point of View Lock

(Available for Operation andMachine Simulation)
This gives the user control over how the virtual cameramoves around the scene, defining the point
of view during animation. The element chosen to be locked then becomes fixed in position.

The choices available for Point of View Lock will be different depending on the renderingmode.

Operator (Machine Sim) Fixes the view to outside themachine.

Part/Fixed Part - (Machine/Op Sim) enables a pull-downmenu to select the spindle to use to sync the
simulation. GibbsCAMwill focus on the stock, and the tools andmachine will rotate around the part.

Machine (Op Sim) This shows the viewpoint fromwithin theMachine. It is similar to Fixed Part, but
shows stockmoving/rotating. Tools do not move around it.

Machine Component (Machine Sim) Locks the view to a particular machine component. Choose from
the pull-downmenuwhich component is to remain stationary during simulation.

Tool Rotary/Linear Axes (Machine/Op Sim) The view will lock on the tool and itsmovements along the
chosen axis.

Show position

(Available for Tool, Operation andMachine Simulation)
This option provides a dialog box showing continuous tracking of axismotion and current feature
information. Sliders allow the user to explicitlymovemachine axis.
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Skip Unselected Ops

(Available for Rapid, Operation, Tool andMachine Simulation)
This option will only render the currently selected operations. (The other operations are still
generated.) This option reduces the rendering time.

Analyze Cut Part

(Available for Rapid andOperation Simulation)
The Analyze Cut Part dialog provides several options to determine the results of the toolpath on a
rendered part. This is an easyway to determine if there are areas on a body that are not being
machined (RemainingMaterial) or if any cuts violate the part. Youmust select a solid prior to
starting Simulation to use the Analyze Cut Part option.
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Trace Options

(Available for Tool Simulation)
This option let you choose how much of the toolpath will remain on the screen — 0%, 1%, 5%, or
100% of the toolpath — as the tool follows the toolpath. Trace Operationwill draw one operation at a
time. Trace From Runwill clear the previous toolpath and begin redrawing if the user stops the render
midway through and restarts.

Machine Component Visibility

(Available for Machine Simulation)
This option opens a dialog box allowing control of the visibility of components in themachine
assembly file. You can control the components individually and/or by the groups set in Build
Machine. The eye icon lets you show or hide a component. Additionally, you can set a specific
transparency level from 0 (invisible) to 255 (solid).
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Don't Block Stock

(Available for Machine Simulation)
Don’t Block Stock is a renderingmode that renders all fixture bodies that appear in front of the stock
bodies as transparent. This allows the user to seematerial removal on stock bodies even when
some other bodiesmove in front of them.

Load Machine

(Available for Machine Simulation)
This option allows you to select whichmachine assembly file will be used for the current part. Once
selected, the samemachine will automatically be used for the part until a different machine is
selected. Clicking User Folder allows you to select a directory that containsmachine assembly files.
Select themachine you wish to use and then clickOK.
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Simulation Context Menus
To display the Simulation context menu, right-click the title bar of the Simulation Control palette.
Left-click to select any of the options.

Legacy CPR Simulation
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Legacy CPR Context Menu

The following options are found in the context menu of LegacyCPR.

Set Op Start/Stop #s...
This option opens a dialog to specify an operation at which to start rendering and/or set a stop point
where rendering will stop and wait for you to start it again. The Start At Op option can be used when
operations have already been rendered once and you would like to skip operations you have
already seen. For example, you have a part with 10 operations and you know the first 7 operations
are correct and render correctly but need tomodify operations 8 through 10. Using this option, you
can skip operations 1 through 7 and start at 8. As long as the tool or operation information for the
first 7 operations does not change, the rendering will jump to operation 8. The Stop Before Op option
will cease rendering before the operation you specify. If you press the Play button, then rendering
will begin again.

Use Op Start
Placing a checkmark on this option activates the Start At Op option. Removing the checkmarkwill
disable the start point specified in the Set Op Start/Stop #s dialog.

Use Op Stop
Placing a checkmark on this option activates the Stop At Op option. Removing the checkmarkwill
disable the stop point specified in the Set Op Start/Stop #s dialog.

Stop Before Load/Unload
Placing a checkmark on this option activates the Stop Before Op option. Removing the checkmark
will disable the stop point specified in the Set Op Start/Stop #s dialog.

All Context Menus

The following options are found in context menus of both LegacyCPR and the Simulation options.

Show Time
This will set the Current Display to show the elapsed cut time.

Show Op #
This will set the Current Display to show the current operation number.

Render Loop
Replays the simulation until the user presses the stop button.
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The following options are only to be found in the Simulation dropdowns:

Save to STL
Select this option to save a copy of the simulation to an .stl file for viewing later.

Save to Bitmap
Select this option to save a copy of the simulation
to a bitmap file. This will re-render your current
state at the specified resolution and save it as a
picture. Please note that most video cardswill
not support saving a picture over 4000x4000.

Create Facet Body
This function turns the current cut rendered condition into a facet body. The facet bodywill appear
in the workspace as a transparent body. Facet bodies can be regarded as other solid bodies: They
can be queried, profiled, sliced, andmachined. One of the uses of facet bodies is that they can be
set as stock for “display only” purposes, i.e. they are not used as a stock condition for creating
toolpath but they can be shown in rendering. Setting a facet body as stock can be quite useful for
saving a rendered condition so you can instantly get to later operations.

Example of a Facet Body used as stock.

Skip pecks
The Skip Pecks option does not render any peckingmoves used in drilling operations. Pecking is still
generated. This option simply reduces the rendering time.
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Don't preload Subspindles
Disables sub-spindle stock generation. This improves performance with the tradeoff of not having
accurate stock on the sub-spindle during the first run. Not available for Tool Sim.

Reload Simulation
This option reloads the simulation.

Skip Interop Moves
Switches off the display of inter-opmoves. Available only for Op Sim.

Graphic Part Face Distance
For use with parts containingmultiple spindles. When enabled, this will render simultaneous display
of multiple spindles. Available only for Op Sim, and standard for Flash CPR.

Show Spinning Part
Displays a transparent solid that represents the stock spinning at high speed, projected over the
subspindle stock. This transparent solid image is called a spun outline. This option is useful for
visualizing stock that is asymmetrical or has deep concavities. It is not useful if the stock is simply a
revolved profile, because the spinning stock is identical to the stock at rest.

Watches
The purpose of the "Watches" function is to graphically display, trace, measure, and analyze the
relationship and the location between chosen point A (Datum) and point B (Reference). These
points can be set to almost any item defined in the current MachineModel. You can choose from the
Trace dropdown either to trackDistance between points or to trace the Path they take.

Multiple watch combinations can be created and displayed at the same time. You have the ability to
differentiate them by Trace Color. To enable or disable watches, check or uncheck the checkbox. To
edit a watch item, double-click it. You can import and export watches as *.smd files.

The locationmeasurements are updated continually during rendering and are displayed on the
Watches dialog. PathTrace lines are shown in the workspace in their chosen color, Distance lines also
display an axis block at each end. Available only for Machine Sim.
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Watch example

Steps to creating a Watch
1. Click the Create watch Icon in theWatches
dialog. Result: The Create Watch dialog opens.

2. Set Datum
3. Set Reference
4. Set watch to either Path or Distance (or turn
Off)

5. Set color
6. ClickOK. The Create Watch dialog closes.
7. Rewind Rendering and play. Path and
Distancemarkers display in theWorkspace.
Location data displays in theWatches dialog.

Sample cut
Enables/DisablesMachineWorks SampleCut technology. Sample cut is a new MachineWorks
technology feature that minimizesmemory used by simulatingmaterial removal at the expense of
accuracy (material removal is accomplished using a 3D grid space instead of the standard facet-
body booleans). Thismeans that an application will only use a fixed amount of memory to render an
arbitrarily complex toolpath which can be of benefit in particularly dense surfacing toolpath where
users have traditionally run up to thememory limits of their computer.

Settings
This option opens the relevant Sim Settings dialog. There are separate dialogs for Op/Tool settings
andMachine Sim settings. (Rapid cut uses theOp/Tool Simulation settings dialog.) Although both
dialogs are essentially the same, they save separate data files. For details on these preference
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settings, see the documentation on File > Preferences > Display > Op/Tool andMachine
Simulation Settings.

Printing the Rendered Image
After the rendering is complete, the rendered image can be printed, either in either black and white
or in color. When the rendered image is on the screen, summon the systemPrint dialog using either

the standard keyboard short (Ctrl+P) or by choosing File > .

Depending on your printer, youmight have very fine control over each printout using the options in

the systemPrint dialog. To adjust default printing preferences, using File > , Display tab,
Printing section. For more information, see “Printing ” on page 24.
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Status Bar

At the bottom of the workspace is a Status Bar which includes amessage display. To the left of a
progress bar, the following items are displayed: current Coordinate System, currentWorkgroup,
current unit of measurement, and current TMS status (such as number of parts) are displayed.

Double-clicking on theWorkgroup and CS indicators will open their respective dialogs. If present,
double-clicking the TMS status indicator will open the DCD dialog to theMulti-part tab.

Hovering over or clicking the progress bar reveals the Progress dialog, which will display real-time
feedback of toolpath calculations and timings. Use the pin symbol indicated below to keep the
dialog open.

Themessages displayed indicate the current function the system is performing, and the progress

bar gives the percent-completed status of the function. Click the Stop button to stop the current
function, if required.

Some Plug-ins, notably Show Position, can be added to the status bar. To do this, click and open
the Show Position plug-in, then right-click the Show Position title bar and check the option to Install
to Task Bar.

To uninstall the plug-in, right-click the icon on the Status bar and select the option Uninstall Task.
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Customizing the User Interface

Command Shortcuts in
Trackball
When you right-click the trackball, its context menu
now offers a powerful choice: Customize.

The Trackball Customization dialog allows you to drag any command to any of the eight slots of
the trackball, using any of eight possible combinations of keymodifiers (Shift, Ctrl, and/or Alt).
This puts up to 64 commands at your fingertips: Press F5 to summon the trackball, press up to three
modifier keys (the trackball display changes accordingly), and click a sector of the trackball.

(Sampl
e) Plain Shift

Plain

Ctrl

Alt

Ctrl+A
lt
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Customizing the Workspace

1. Right-click here to Customize
2. Do it/Redo Command.
3. Alternative command docking areas

Some customization is available within the workspace. For instance, from the tile right-clickmenu
you can select large or small tile size. Right-clicking a process tile also enables the Do it/Redo
controls that are attached to the process tiles to be hidden or shown. (The Do it/Redo commands
are still available at any time by right-clicking in the workspace.)

The File>Preferences>Interface tab has options to control the Startup window size, the
Transparency of the Floating Toolbar, the dialogs and the tile lists and also various other controls.

Other more sophisticated customization is possible by right-clicking within the header area
highlighted within a red box in the screenshot above. You can totally rearrange, or duplicate
command icons and place them into existing or customToolbars andMenus. For instance this
would enable you to create a commandmenu specifically for your own oft-used workflows.
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Customizing Toolbars and Menus

Access the Toolbar andMenu customization function by right-
clicking anywhere in the Title or Commands Toolbar. When you
are in customizationmode, functionality that affects the
workspace is temporary disabled. The following dialog will
appear:

The checkboxes in the Customizationmenu can be used to quickly show/hide theGibbsCAM
Toolbar groups. Click the option Customize Toolbars & Menus to open themain customization dialog.
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Save/Load Customization Profile

These options enable you to save and load your customizations to and from a *.cui file. This way it
is possible to set up customizations for specific tasks.

You can also load a copy of the as-shipped default UI at any time.

For your convenience, three preset interface *.cui files are available.

A Level 2 Legacy Interface is provided. This allows you to use Level 2 as it was before
GibbsCAM 12. Or, you can choose from the standard GibbsCAM 12 Level 1 and
Level 2 Interfaces.

To load an interface, from the bottom of the Customizationmain screen, click the
option Load Customization Profile. Navigate to the following folder:

C:\ProgramFiles\3D Systems\GibbsCAM\<version>\User Interface Layouts

Double-click the required option.

Note: When you load a package file (*.gcpkg) that contains user interface customizations, the
system offers you the option of applying or rejecting the customizations before loading the package
contents.

New Menu Button

TheNew Menu Button dialog lets you name a new command container and provide tooltip text
strings and an icon for it. After a command container has been dragged onto a toolbar or into a
menu, you can drag one or more commands into it.
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Command Name
The text string that will label the command container.

Short Tooltip
The text string that will appear when themouse hovers over the command container.

Long Tooltip
The text string that will appear onmouseover if Balloons are turned on.

Icon

If you do not use the (Browse) button to navigate to and choose an *.icn file, then default icon

will be .

OK: Accept changes and close the dialog.

Cancel: Discard changes and close the dialog.

Keyboard Shortcut List

The Keyboard Shortcut List dialog lets you display and print a list of all commands that have keyboard
shortcuts assigned.
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Keyboard Shortcut List
Icon CommandName Shortcut(s)

Balloons Ctrl+B

Bottom Alt+Ctrl+E

CAM Ctrl+4
F4

... ... ...

Zoom In Ctrl+OemPlus
Alt+DOWN

ZoomOut Ctrl+OemMinus
Alt+UP

Commands tab

This tab contains all the GibbsCAM command icons available for UI customization.

Search
A search function is provided at the top of the screen. This searches not only the command titles,
but also the Tooltip descriptions to enable you to find the correct command.

Shortcuts
The commands tab is also used to set up new keyboard shortcuts. Click to highlight an icon. A box
will appear if it is available for shortcuts. Simply hold the Ctrl or Alt key, together with the character
you wish to use for the shortcut. If the shortcut is not already in use, it will appear in the box. Click
any other icon to enter, or click the x next to the box to delete. If a shortcut is already in use, a
warning will be displayed. You then have the opportunity to reassign the existing shortcut, or
choose another.
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To insert a command
Click, hold and drag the required command icon either into a new or existing
command group or mainmenu dropdown. If you hover over aMainMenu
option (File, Edit, View etc.) the dropdownwill automatically open. Move the
icon around and you will see an orange bar. Once this bar is positioned just to
the left of where you wish to insert the command, let go themouse button and
the icon will drop into place.

When in Customizationmode. a command can be inserted into either aMenu
dropdown, the Floating toolbar or an existing Toolbar Command group. Items
placed anywhere else will disappear into the trashcan. It is especially
important that you are aware of this if you aremoving existing icons. If
inadvertently deleted, theymust then be reinserted.

Reposition an icon
If your command has been place incorrectly, simply click, hold and drag it into the correct position.
All existingmenu commands can also bemoved around in thismanner.

Right-click menus
Right-clicking a command icon in the UI while in Customizationmode gives additional options to
arrange the commands by adding separators or extra lines. Please note that only one separator
can be added in a particular space. Clicking Add separator a second time will remove it.

Right-clicking an icon in theMain-menu dropdown Right-clicking an icon in the toolbar
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Menus tab

Use theMenu tab to create a new MainMenu option or to add a
sub-section to an existingmenu. You can also change the width
of theMainmenu dropdown - just type in the required number of
columns and click the column icon next to it. Menu options can
be renamed, or if need be, deleted.

Rename/Delete/Reset Buttons

You can rename or delete anymenu or toolbar. The Reset option will reset sub-menus back to the
default condition.

Note: Take care not to delete top levelmenu items (MainMenu options like File, Edit. View etc that
appear in the header bar), or the actual command Toolbar groups, unless this is what you intended.
The Reset option will not work for these. The only way to recover these deletions is to reload from a
saved Profile.

Toolbars Tab
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Enter a title into the New Toolbar box and hit return. A new Toolbar Command Box is created. You
can then drag command icons into this new box from the commands tab. The new menuwill also
appear on the Customize screen and can be switched on/off using a checkbox, just as with the
default groups.

To add items to the Quick Access or Floating Toolbars, just drag the required command into the
toolbar.

Positioning Command Toolbar Groups

Command Toolbar groups can be pinned to the outer
margins of the workspace (Left, right and bottom).

In Customizationmode, click and drag the Toolbar
Command Box grip point (the group of 8 dots in the top
left corner of each toolbar).

The cursor will change to a white arrow and an orange line appears when the group is in a location
where it can be inserted.

The orientation automatically adjusts to fit the available space.

Exit

Once you have finished customizing the UI, click the close or Exit button (situated in the bottom
right corner of the customization dialog). This will save the changes and return to normal
GibbsCAM functionality.

Moving Command Groups around the workspace.

Once you have exited customizationmode, you can click and drag command groups to any location
on your screen, or even onto a different screen.When you close and reopenGibbsCAM the group
will appear where you last left it. To return a group to a docked position, drag the group using the
grip point, this will activate the orange guideline and the group will then snap into place. You do not
need to be in Customizationmode to do this.
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Miscellaneous
• Lists

• “Other Workspace Items” on page 179

• “Shortcuts” on page 180

• “Cursors” on page 181

• “Eyeball icon” on page 183

• “Freehand Actions” on page 183

• “Right-Click” on page 185

• “Colors” on page 185

• “Math Functions” on page 187

• “Interrogate ” on page 187

• “About Clearance Volume ” on page 189

Lists

There are threemain lists in the system. These are the Tool List, the Process List and the
Operations List. These lists hold tiles and are not moveable. Each tile is used to describe an
individual tool, process or operation. A list can holdmany items.
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To scroll through a list, click on the large blue arrow at the top or bottom of a list. This will
move the list up or down one item at a time. Listsmay be scrolled through quickly by clicking on
the scroll arrow and dragging themouse past the arrow. This is called Speed Scrolling. When
Speed Scrolling, the list advances six tiles at a time. The arrow will turn red when Speed Scrolling.

You can also scroll to the first or last non-empty tile by clicking the smaller button next to the
single-scroll button.

Hold down the Shift key and double-click on the triangular space between process tiles to create
an empty space between processes. Hold down the Shift key and double-click on an empty space
between process tiles to delete the space between processes. To navigate through the lists faster,
use a context menu command.

Right-clicking on either of the arrows in a list will bring up amenuwith the Find command.
Right-clicking on a tile will bring up amenu to select the Find or Move dialogs.

Find Tile dialog Move Tile dialog

Tool List

The Tool List and its (right-click) context menu
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The Tool List is used to define the tools used to cut a part. By double-clicking on an empty tile a
new tool is created and a Tool dialog opens. A tool is then fully defined within the Tool dialog. This
includes, but is not limited to, the type of tool and its size andmaterial. Only one Tool dialog can be
open at a time.

Tool tiles display a graphic of the tool type and the size of the tool. This instantly changeswith any
modifications to the tool. Tool Listsmay contain bothmilling and turning tools at the same time.
Each tool has a unique graphic to help the user quickly determine what each tool is.

The Tool List is accessed from the Tool button in the Commands palette. There can be amaximum
of 999 tools in a part. The tool tiles do not have to be contiguous; there can be empty spaces
between tiles.

To navigate through the Tool Tiles, click on any part of the Tool List to select it. Then use themouse
wheel to scroll through the list. Use Ctrl+themouse wheel to scroll throughmultiple tiles at a time.
The Process List andOperations List, described elsewhere in this section, can also be navigated in
thismanner.

Tool lists can be saved and even automatically generated by using default part files. See “               Type
Default Part ” on page 12.

View/Edit Tool List

Tool List Manager lets you:

• Hover
over a tile
in the
dialog to
show the
Tool
Preview in
the hover
window.

• Order
tools by
tool type
(default),
by tile
number,
or by
toolgroup.

• Use the search bar to find a tool by text and/or by itsmost important dimension, optionally
filtered by toolgroup.

• Delete a tool from the tool list.

• Drag a tool from the tool list to the part or vice versa.
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Save or Load Selected Tools

To save a set of tools:
Select the tool tiles, right-click any non-blank tile in the Tool List, and choose Save Selected Tools.
To load a saved tool list file: Right-click a blank tool tile, choose Load Tools from the context menu,
and then navigate to and select the tool list file (*.tlst) that you want to load.

Tool List

To load: Right-click a blank tile and choose Load....

To save: Select one or more tiles, right-click any non-blank tile, and choose Save....
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Process List

The Processes List and its (right-click) context menu

The Process List is used to define toolpath and create operations. A process consists of a single
tool from the Tool List and amachining function. When a Process tile, a process is created.

Clearance values, cut depth, speeds and other items are specified in the Process dialog. In most
cases, geometry or a solid is then selected to generate toolpath by clicking the Do It button. Once
toolpath is generated, one or more operations are created for each process. After operations are
created, the processes can be thrown away, because the information from the process is stored in
the Operation.

Please note that multiple processes can be created in the same list. This will causemultiple
grouped operations to be performed on the same geometry or surface. This function can be used to
drill, bore, and tap — all in one set of operations. It can also be used to create a set of operations that
drill, rough, and contour the same geometry or solid. Any combination of machining functions can
be grouped as needed.

The Process List contains amaximumof 99 Process tiles. The Process tiles do not have to be
contiguous; there can be empty spaces between tiles.

Save or Load Process Lists

Process List
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To save: With one or more process tiles selected, right-click a non-blank tile and choose
Save Process List....

To load: Right-click a blank process tile and choose Load Process List.
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Operations List

TheOperations List and its (right-click) context menu

Operations are created from processes and tools. Operations store the toolpath (the cuttingmotion
of the tool) and the information defined by a process. A process generates at least one operation,
some processeswill result in more than one operation. The software will use the list of operations to
generate the final program that is sent to the CNC machine.

Theremay be amaximumof 16,000 operations in a part. TheOperation tiles do not have to be
contiguous; theremay be empty spaces between tiles.

TheOperations List has a larger context menu than the other lists. Themenu contains a number of
commands that can be applied to an operation or its toolpath. The normal Find andMove options
are also included. For detailed information, see theMill and Lathe guides.

Operation Tile Stacking

TheOperations list offers four choices for organizing Op tiles:
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1. Individual: Unstacked.
2. Process Mode: Consecutive operations are stacked
together if they originated from a single process and all
belong to the same flow.

3. Process List: Consecutive operations are stacked
together if they originated from a group of processes to
machine the same geometry—and all belong to the same
flow.

4. Manual: Allows you to create stacks of consecutive
operations that all belong to the same flow. Can include
blank tiles and operations on different spindles.

Appearance and Behavior of Op Tile Stacks

Tile stacks differ from single op tiles as follows:

• Stack of frames. The process icon is framed to suggest a stack of icons.

• Tile number. The stack is numbered according to the first op tile in the stack,
followed by an ellipsis ... indicating a break in the numeric sequence between it.
In the illustration, 21... is above op tile 23; 5... is above op tile 8.

• Tool numbers. A single tool number indicates that all ops stack share the same
tool. If the ops use exactly two tools, then the first-used is separated from the
second-used by a comma(T 11,12 in the illustration). If the ops use three or
more tools, the first-used is separated from the last-used by a colon(T 6:4 in the
illustration).

• Extended tile numbers. Numbers for toolgroup, tool ID, and spindle number
are displayed only if all ops share the same value. In the illustrations, toolgroup
and spindle are shared by all ops in each stack; tool ID is not.

Which Process Icon Is Displayed?

If all operations share the same process type, the stack displays that icon.

For Process List, the stack icon indicates the highest-priority process type in the process list. For
example, if a process list consists of Holes, Pocket, and Contour , stack displays a Pocket icon.
When two or more processes of equal priority exist (such as Pocket and VoluMill), the stack
displays the icon for the earliest process.
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ForManual, the stack icon shows the process type of the earliest
operation.

Opening, Closing, and Scrolling a Stack of
Op Tiles

Double-clicking a stack opens a flyout that shows a list of op tiles it
contains:

To close the flyout: click its close icon or move/resize the GibbsCAM
window.

Just as in themain op list, a sufficiently long flyout list provides a scrollbar
that lets you navigate up and down.

About Manual Stacks

ChoosingManual op tile stack display creates the following special
conditions:

• The context-sensitive (right-mouse-click) menu offers two additional items:

- Create Stack Allows you to create amanual stack. ForManual only, a stack can consist of one
tile.

- Unstack Undoes themanual stack of the right-clicked item.

• The part "remembers" all manual stacks even when it is in a different mode. ReselectingManual
will restore the previousManual display state, unlessmanual stacks have been broken by other
op tile additions, moves, or deletions.

Dragging and Dropping

You can drag an entire stack and drop it anywhere in the op list or into another stack. When a stack
flyout is open, you can drag tiles into or out of the stack. However:

• Dragging a tile into or out of the stackmay cause the stack to break into two stacks if the rules
for that stack cannot all be kept.

• Dragging a stack into the flyout of another stackmight result in two or three stacks if the rules for
the target stack cannot all be kept.

• Dropping a stack onto a stack does nothing.

Extended Tile Lists
If the GibbsCAMwindow is sized large enough, additional slots will be visible in the tool and
operation lists. You can increase the size of the GibbsCAMwindow by dragging the lower right
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hand corner or by clicking theMaximize button tomake the window grow to the full size of the
screen.

You can view more tool icons by dragging down the bottommargin of the Tool Tile list. Drag it up
to seemore Process Tiles.

To increase the number of tiles on view you can also switch to Small icons.

Dockable Panes
Many dialogs can now be docked — that is, attached to the left,
bottom, right, or top side of the workspace or to each other
(creating a tabbed window). These dialogs include: Body Bag,
ProgramError Check, CS List, Workgroup List, Operation
Manager, ToolManager, ProcessManager, and a few others.

Clicking in a dialog’s titlebar activates the Docking Control in
the workspace and in the center of each docked pane. Dragging
the dialog onto an outward-pointing arrow (up= , left= , right=
, down= ) docks it to that side, and dragging it onto the center

( ) adds a tab.
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Right-clicking the titlebar of a
dialog in a tabbed pane lets you
set tabs at top or bottom.

Other Workspace Items

Workspace
Theworkspace occupies the entire window space. It can bemoved and repositioned using the
View Control palette or keyboard shortcuts. All drawings of geometry, toolpath, and rendered
images appear in the drawing window. The overall size of the workspace is defined by the
Document Control dialog settings and represents the default stock condition. To change the size of
the window, move themouse pointer to the outer border and when a double arrow appears, click
and drag to the desired size. Use the Viewport manager in the floating toolbar to view in GibbsCAM
Multi view mode.

Axis Block

The axis block shown above is, for most users, permanently displayed on the bottom left corner of
the screen and indicates the orientation of the part displayed. However, if your computer does not
haveOpenGL installed, or if OpenGL is disabled, then the axis block is not displayed. If you want to
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suppress the axis block display, or display it on another corner of the workspace, go to Preferences:
File > Preferences > Display tab, Edit Appearance Settings button > Background tab. See “Appearance
SettingsDialog” on page 17.

If you hover over the axis block you will see a view palette that you can use in a
similar way to the View palette on the CommandGroupmenu.

Click on geometry and press Ctrl+Alt to display a temporary axis block at
that location. For more information, see the section on Freehand Actions.

Trash
The Trash is a graphical method for deleting on-screen objects such as tiles in a list, geometry or
solids. There are two ways to use the Trash. The first method is to click the Trash button which will
delete any active and selected item. Multiple elementsmay be selected, such as one or more tools,
operations and geometry. Please note that only the currently active itemswill be deleted. Active
items are usually found in the last selected window. The secondmethod is to drag tiles to the Trash.
The last deletion is undoable by selecting Undo from the Editmenu or by pressing Ctrl+Z.

Shortcuts
Button Shortcuts
In some cases, buttonsmay be depressed by actions other than clicking on them.When a button
has an outline around it or is highlighted, it can be selected by pressing the Enter or Return key.

Geometry Dialogs give the user a choice of single or multiple feature creation. To create only one
feature (a circle, for example), click the single circle button. To createmore than one circle, click the
multiple circles button. One of the buttonswill always be highlighted. The highlighted button can be
depressed by clicking on it, pressing the space bar, the Enter key or the Return key. Pressing
Shift+Enterwill select the unhighlighted button.
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The Do It button is found in some dialogs, primarily those found in theModifymenu. It can
be depressed by clicking on it or by pressing the Enter or Return keys.

Command Shortcuts
Keyboard shortcuts can be set up for often-used commands. See the section on Customizing the
User Interface.

Palette Shortcuts
There are some keyboard shortcuts for functions other thanmenu choices in the system. Simply hit
the appropriate number to activate the button.

Geometry Creation palette Point sub-palette

Line sub-palette Circle sub-palette

Auto-Shape sub-palette Geometry FromSolids sub-palette

Cursors
The cursor is the screen object moved with themouse. Its appearance changes depending on its
location and will dictate its usage.

Pointer

This cursor is used to select objects and geometry by clicking on them. You can
zoom by dragging a rectangle around an area on the screen as shown right.
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Area Select
Thismode is accessed by holding down themouse key and

dragging themouse or using the Edit > Select > Mouse Drag
command. Geometry with any of its area appearing within the
rectangle will be selected in its entirety.

Pointing Finger

This indicates that the cursor is holding an object, such as a tile, that is beingmoved. It is also seen
whenmoving the workspace using Ctrl-leftmousebutton drag.

Edit/Input

This indicates that the cursor is over a text or value input location. Clicking in the text boxwill
produce a flashing text cursor to enter or edit the field.

Interrogation Cursor

This cursor appears when the Alt key or Shift+Alt keys are held down. The Interrogation cursor
is used to automatically enter values from geometry, profiler arcs, circles, and solids into text boxes.

Spot
The cursor changes to this while rolling the trackball in the View palette or while a handle of the pop-
up axis block is being dragged for freehand rotation or translation.

Small Pointer

The small pointer appears when the Ctrl key is held down. It allows for more than one item to be
selected at a time.

Hand Pointer
This appears when selecting commands from sub-palettes

or  Resize: Horizontal
This cursor signals that the window or pane can be dragged horizontally to increase or decrease its
width.

or  Resize: Vertical
This cursor signals that the window or list can be dragged vertically to increase or decrease its
height.

Help on item Cursor

This cursor is activated from the Floating Toolbar Help button or when you select the same
command from the Helpmenu. This cursor is active until you click on an item in the GibbsCAM
interface.

The Help cursor activates context-sensitive online help for the item you click on. Online Help will
open and will attempt to load the section regarding the item you clicked. Some items go to a very
specific topic; others will lead to a general section of the help.
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Move
This cursor can be found in conjunction with command toolbar groups. Hovering over the drag point
(the group of 8 dots in the top left corner of a group) the cursor changes toMove and allows a group
to be dragged to another position. Caremust be taken with this however a group could become
hidden if inadvertently dragged out of the visible area. For more information see Customizing the
User Interface.

Eyeball icon

The eyeball icon is used inWorkgroup, CS and Hole Manager Group list dialogs. An
open eyeball means that the item is displayed in the workspace, a closed eyeball means that
it is hidden.

A singlemouse click places a box around the eyeball. This is a selectionmarker box. You can select
multiple eyeballs (either one at a time using (Ctrl-click) or by specifying a range (Click,
Shift-click). Double-clicking inside any one of the selected eyeballs will then either deselect
or select all items.

Please note that you cannot close the eyeball if aWorkgroup or CS row is highlighted in blue, as
this is the activeWorkgroup/CS.

Freehand Actions
Do not confuse actions that scale / pan / rotate the view from actions that affect elements such as
2D geometry or bodies.

For example, the following actions affect only the current view:

• All mouse actions in the View Control Palette, such as:

- Drag and right-drag (  cursor) of the trackball axis handles, for constrained rotation or of
the trackball itself, for unconstrained rotation.

• Ctrl-drag(  cursor) to move the workspace.

• Mousewheel-turn to zoom and mousewheel-drag to rotate the workspace.

• Hardware controls on 3D motion controllers such as spaceballs

• Gestures on touch screens

In contrast, as you would expect, items on theModifymenu affect elements selected in the
workspace and Body Bag, and have no effect on the view.

An entirely different class of actions, freehandmove and rotate, affects selected elements in the
workspace by creating andmodifying coordinate systems on the fly.
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Freehand Move and Rotate

You canmove or rotate elements using themouse: Select one or more elements, press Ctrl+Alt
to pop up a temporary axis block, and then drag either the origin (for freehand translation) or one of
the six axes (for axis-constrained translation or rotation).

The pop-up axis block remains displayed for as long as the Ctrl+Alt keys are held down. If you
add or remove bodies in the selection set, the pop-up axis blockmoves to the center of the
bounding box (theminimumbox containing all currently selected elements). To zoom in or out on

the view, use the Down ( ) and Up ( ) keys.

Pop-up axis block showingmove (1 or 2) and rotation (3)
operations

1. For a freehandmove operation of selected elements, click
and drag the origin of the pop-up axis block.

2. For a freehandmove operation along one axis of the pop-up,
click the axis arrow's shaft or arrowhead and drag along the
axis.

3. For a freehand rotation operation around one axis of the
pop-up, click the spinner around the corresponding axis
arrow and drag. The closer to the axis origin, themore
extreme the rotation.

When hovered over a handle, the cursor becomes a pointing

finger ( ). As themouse button is clicked and held, the
cursor becomes a fist ( ).
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When a freehandmove or rotation operation is performed, a new or modified CS is associated with
each body and profile that has been shifted. The CS is labeled with the comment Freehand CS.
Subsequent translations and rotations of the body or profile will update the associated CS.

Right-Click

Themouse has (at least) two buttons that are used in different manners. The left button
selects/deselects and accesses items such as geometry, bodies, text boxes, and buttons. The right
button gives access to context menus that contain items specific to the selected object or objects.
You can right-click a title bar of some dialogs to open amenu containing items specific to that
dialog.

An example of a context menu is shown above.When you right-click the title bar of the History
list, its context menu appears. The context menu only contains options that are applicable to the
History list.

Colors
The system uses colors to graphically display different items drawn on the screen. All system colors

may be customized in File > Preferences > Display tab > Colors tab. The default color scheme for
geometry, toolpaths, and rendering is listed below.

Item Color Meaning
Workspace White Wire frame view of the Part Stock and coordinate systemmarkers

Green Profile Grid
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Item Color Meaning
Geometry Yellow Unconnected Geometry or a terminating Point

Dashed Yellow Unconnected Rapid Geometry

Light Blue Connected Geometry

Dashed Light Blue Connected Rapid Geometry

Red Geometry designated as “Air” geometry for machining

Gray Geometry viewed as a background workgroup

Magenta Geometry viewed in a background coordinate system

Toolpaths Dark Blue Cut Shape; selected area of a shape to bemachined

Solid Orange FeedMove in Toolpath

DashedOrange RapidMove in Toolpath

DashedGray RapidMove used for positioningmoves and tool changes

Solid Gray Approach FeedMove

Solids/Sheets Gray Solid Body

Yellow Selected Body (solid or sheet)

Blue Stock; Selected Profile

Red Fixture or negative depth side of a sheet

Light Blue Sheet or plane
Green Deselected Profiles

Rendering Blue Stock

Yellow Rendering of selected operations and/or selected tools

Gray Rendering of unselected operations and/or unselected tools

Red Tool Interference

Hole Manager
TheHoleManager draws an “X” at the top of the hole and a line leading to the drill point (the final
depth), for each hole. The color of the line and “X” will vary depending on the hole type.
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Drill Tap Ream Bolt
Hole

Spot
Face Bore Bore,

Thru
Back
Bore

Com
pound

Green Blue Yellow Magenta Cyan Brown Dark
Green

Dark
Blue White

Math Functions
All numeric input boxeswill accept the four standardmath function symbols (+ - x /) as well as a
number of special functions (either * and x can be used for multiplication). Pressing the Equal key
or Tab key on the keyboard will display the final value. The following list provides all of themath
functions recognized by the system.

Key Function Key Function
+ addition – subtraction
* multiplication x multiplication
/ division = equals
m convert inch tometric (x25.4) i convert metric to inch (/25.4)
s sine c cosine
t tangent a arc tangent
r square root e scientific notation (41e-2 = 0.41)

Interrogate
When a text box contains a cursor, you can Alt+click a point or other element (including toolpath)
to interrogate its value and place it into the text box.

The contents of any text boxes can be cut, copied and pasted to and from the Clipboard by
choosing items from the Editmenu or by using Ctrl+C, Ctrl+X, or Ctrl+V.

Please note that angular values entered in text boxes follow the standard Cartesian coordinate
system, as shown. Negative values are acceptable as input.
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Appendix
• A Discussion About OpenGL

• Recommendation

• Known Issues and Fixes

• FAQ (Frequently AskedQuestions)

About Clearance Volume
Clearance Volume allows users of advancedmachines to say to GibbsCAM, in effect, “Here’smy
part; don’t let the tool come too close to it except when cutting. You figure it out so I don’t have to.”

Clearance Volumewas devised to address situationswhere the traditional clearance plane (CP1)
is not a goodmatch for machines of more than three axes, especially those with rotary heads or
tables, tools with right-angle heads (or any tool that is not Z-aligned), vices that can be held at
varying B-axis angles, and the like.

For turning, Clearance Volume is required for eccentric turning, where clearancesmust be
calculated from aCS that is not parallel to the base XZ axis.

The clearest example of where Clearance Volume is beneficial isWillemin 508MT and 508MT2
machineswhere vice and tool can be rotated independently, making it impossible to provide legacy
MDD settings for interopmoves that are logical and reasonable. Anymachine where tool stations
and part stations are independently rotatable can be a candidate for Clearance Volume.

Clearance Volume can also be useful for simplemachineswheremore efficient clearances are
desirable for interopmoveswhen the tool retracts to accommodate rotation, especially when
machining a tall part. This occurs on 5-axis tablemachineswhere the fourth axis is distant from the
part, and on B-axismill-turns where the tool goes home between B-axis orientation changes. In
cases like these, if you can keep the tool near the part, you often get faster run times.

Generally: If it is very difficult to calculate the “right” CP1, or if there is no right CP1, then Clearance
Volumemay offer a better solution.

Caveats: Interopmoves generated byClearance Volume contain 5-axis simultaneousmoves; thus
it is best if the control has TCP capabilities, and it is unsuitable for machines that have indexing
rotary axes or rotary axes that must be clamped betweenmoves.

User Interface

In theMDD, Clearance Volume should be implemented byResellers and/or the Gibbs Post
Department. We do not expect end users to exercise Clearance Volume options in theMDD.
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When theMDD implements Clearance Volume, a new command is available: Show
Clearance Volumes. You can find this command in the Customization dialog and customize the
user interface by placing it on a toolbar or menu group.

DCD.When anMDD
specifies Clearance
Volume, the DCD for aMill
part changes: instead of
Clearance for a plane
positioned above the part
origin, it has Clearance (Δ) as
an incremental offset from
the default stock definition.

Machine Space and Part Space

Machine spacemeans “absolute; from the standpoint of themachine”; part space is relative to the
part, whichmay bemoving with respect to themachine.

Example. When a vinyl record is played on a turntable, consider the path of the needle.

• From the standpoint of themachine, it makes a nearly straight-line traversal from the outside of
the disc to the inside.

• From the standpoint of the record, the needle traverses a very tight inward spiral, with
occasional small breaks. This follows the spiral tracks in the vinyl.

G-Code

All machines output G-code inmachine space; somemachines also have amode that enables part
space instead of machine space. Machine Space requires accurate offsets (i.e., tool and part and
rotary positions in theMDD), andmay be unsafe when inaccurate offsets are entered. Part Space
ismore forgiving. But: Note that “Turning Enabled” causes Part Space to be ignored.

In most circumstances, the superior output takes advantage of themachine’s interpolation
capabilities to create smooth lines and arcs, instead of creatingmany tiny segments that
approximate a curve.

A Discussion About OpenGL
OpenGL enables several graphic features and provides enhanced rendering of solids. If you have a
fast video card with amplememory it can improve rendering performance, because rendering is
done by hardware and software (the driver) on the video card and not by your machine’s CPU.
Everymake andmodel of video card is different. Performance, display quality and display behavior
will vary from card to card. In general, if you have a graphics problemwhen using OpenGL, you
have three options on how to proceed.

1. Use the software driver setting, eliminating the video card hardware and driver use. This will
use the genericMicrosoft OpenGL implementation.
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2. Disable OpenGL, which uses theGibbsCAMdisplay software entirely for rendering. Thismay
be your only option when all else fails. However, the axis blockwill not display.

3. LeaveOpenGL enabled and try a different combination of OpenGL and/or driver settings to see
if the display issues can be resolved.

Recommendation
• Modifying some of the Appearance options can adversely affect the display of GibbsCAM. In

particular, changing the title bar size and the associated font canmake items illegible. We
recommend that you not change these items.

Known Issues and Fixes
• When dragging dialogs or windows there can be a “smearing” or after-images of the dialog.

This is a normal effect of Windows® settings andOpenGL. If you find this effect undesirable it is
easy to fix by turning off the “Show window contents while dragging” option. We recommend this
to all users.

- Right-click on the desktop and select Properties.

- Select the Appearance tab and click on the Effects button.

- Deselect the “Show window contents while dragging” option and clickOK.

• If your system has an ATI video cardmoving the display trackball can cause the display to
flicker. This is an issue with ATI drivers and the operating system.

FAQ (Frequently Asked Questions)
• How do I eliminate empty spaces in a list?

Using a Shift+double-click on the empty space will clear the space.

• My entire screen just went black and I can't see any geometry. What happened and how
do I fix this?

In all likelihood, you accidentally zoomed in on the part using amouse drag. There are three
ways to fix this.

1. On the View menu, select Unzoom.

2. On the View Control palette, select Unzoom.

3. Press Ctrl+U.

• Why can’t I access posting?
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Operationsmust be created before accessing Post dialogs. If you need to get to the Post dialog
before creating your part, make a dummy operation (such as drilling a point). This can be done
very quickly and can be deleted later.

• I can't drop my Operation tiles on my Process List. Where are they?

Operation tiles can not bemoved away from theOperation List. They can be sorted and
reordered. To edit an operations process information, double-click the operation to load its
process to the Process List.

• The Chamfer Radius button is not working!

Turn on labels (Ctrl+L) to identify possible overlapping points. Youmay also have input an
edgebreak value that is too large.

• When I draw an element, it does not appear

Elements drawn outside of the stock boundary described in the Document Control dialogmay
not always be visible. Try zooming out or increasing stock size. Using the Shrink Wrap command
(Ctrl+‘) will automatically adjust the window to fit all geometry (including geometry in hidden
workgroups or the Body Bag). Shrink Wrap Visible (Ctrl+]) adjusts the window to fit visible
geometry only.

• GibbsCAM has become corrupted and will not restart!

Installed in the same folder as the GibbsCAM software is an application named Recovery.exe.
Instead of having to reinstall GibbsCAM, try running the Recovery.exe application. This should
repair most damage done to GibbsCAM. It is also possible thatWindows caused a corrupted
process that was not fully able to close. Using theWindows TaskManager (Ctrl+Alt+Delete)
you can verify that GibbsCAM (virtual.exe) is not still running. If the process is still in the list you
may try to End Process and if this fails youmay need to reboot your system.

• Where do I install my hardware key?

Keys can be inserted into anyUSB port in the computer or connected USB hub.
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Conventions
GibbsCAMdocumentation uses two special fonts to represent screen text and keystrokes or
mouse actions. Other conventions in text and graphics are used to allow quick skimming, to
suppress irrelevancy, or to indicate links.

Text

Screen text.  Text with this appearance indicates text that appears in GibbsCAMor on your monitor.
Typically this is a button or text for a dialog.

Keystroke/Mouse.  Text with this appearance indicates a keystroke or mouse action, such as
Ctrl+C or right-click.

Code.  Text with this appearance indicates computer code, such as lines in amacro or a block of
G-code.

Graphics

Some graphics are altered so as to de-emphasize irrelevant information. A “torn” edge signifies an
intentional omission. Portions of a graphicmight be blurred or dimmed to highlight the item being
discussed. For example:

Annotations on a graphic are usually numbered callouts (as seen above), and sometimes include
green circles, arrows, or tie-lines to focus attention on a particular portion of the graphic.

Faint green borders that outline areaswithin a graphic usually signify an imagemap. In online help
or a PDF viewer, you can click a green-bordered area to follow the link.
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Links to Online Resources

Link URL Action / Description

Go http://www.GibbsCAM.com Opens themain website for GibbsCAM.

Go https://online.gibbscam.com

Opens a restricted website containingmaterials
available for download. Requires aGibbsCAM
Online Services account; to set up an account,
contact GibbsCAM Support.

Go https://store.GibbsCAM.com
Opens the website for the GibbsCAM Student
Store.

Go https://macros.gibbscam.com
Opens a wiki containing documentation and
examples of GibbsCAMmacros. Requires a
GibbsCAM account.

Go http://kb01.GibbsCAM.com

Opens a Knowledge Base article, Contour
Operations Using Thread Mill Tools, that
explains in detail the correct way to program
Contour processes using ThreadMill tools.

Go mailto:Support@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIO Technical Support
department for GibbsCAM.

Go mailto:Registration@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIORegistration
department for GibbsCAM.

Go mailto:Sales@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIO Sales department
for GibbsCAM.

Go http://www.autodesk.com/inventor
Opens an external website that provides more
information on Autodesk Inventor products.

Go http://www.celeritive.com
Opens an external website that provides more
information on VoluMill Ultra High-Performance
Toolpath (UHPT) from Celeritive Technologies.

Go http://www.predator-software.com
Opens an external website that provides more
information on a CNC editor and a virtual CNC
viewer from Predator Software, Inc.

http://www.gibbscam.com/
https://online.gibbscam.com/
http://store.gibbscam.com/
https://macros.gibbscam.com/
http://kb01.gibbscam.com/
mailto:Support@gibbscam.com
mailto:Registration@gibbscam.com
mailto:Sales@gibbscam.com
http://www.autodesk.com/inventor
http://www.celeritive.com/
http://www.predator-software.com/
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% of Body’s Chord Height 27

2

2016 PDFs 99

2D Rotate 72
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3D Real Time Cut Part Rendering 137

5

508MT (Willemin)
and Clearance Volume 189

A

About GibbsCAM 102

Absolute 2d Rotate 72

Absolute or Incremental, in post 45

Absolute Translate 73

Activate Dialog on RMB 17

Active Content 105

Additive Preferences 51

Air geometry 76

Alloy Group 53
material 54

Alloys 54

Ambient 18

Ambient, Material Properties 18

Angle, 2D Rotate 72

Angular Resolution 27

anonymous usage statistics 33

Apply Value to Selected
Managers 93

Approximate Arcs 28

Arc segments 77

Attribute Manager
menu item under Features 85

Auto Tool Size 15

Axis block
about 180
pop-up 184
showing/hiding 20

Axis Limits 147

Axis Marker in Sim 20

B

Background Tab, Appearance
Settings 20

Balloons 100

Bitmap 153

Block Numbers 134

Bodies (Graphics) 24

Bodies, Select 61

Body Chord Height 27

Bolt Table 38

Bookmarks, online help 104

C

Calculate
Feed 57
RPM 57

Cascade Dialogs 87
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Index: Change CS (HVD) – Dialogs, control over

Change CS (HVD) 71, 78

Change CS (XYZ) 71, 78

Change Intersection, Geometry
Expert 63

Check
Body Validity 81
Face Validity 81
Op Gouges 82
Self-Intersect Loops 80
Trimmed Surface Edges 82
Trimmed Surface Polyline 82

Check for Updates 101

Check Out, NLO seats 34

Chord Height 24, 27, 77

Circles, Select 60
All Circles 60

Circular Threads 27

Clear Bodies’ History 83

Clearance (Δ) 190

Clearance Volume 189

Closest Hole Next, sort 76

Collision events 146-147

Color Button 23

Colors Appearance Setting 18

Comment 54-55

Comment, select by 62

Common Appearance Settings 17

Communication dialog 13

Communication Set-Up 47
Protocols 47

Change 48
Remove 48

Communications 13

Condition 54

Configurations, system display option 17

Contents, Help 98

Contents, online help 103

Context Sensitive Help 99

Contouring 36

Coordinate Systems
Creating and Modifying Options 43

CPR
Current Display 139
Next Operation 139
Play 139
Speed Control 139

CPR/Sim Appearance Settings 19

CRC 36

CRC Type 35

Create Facet Body 153

CS Preferences
Geometry References 43
Out of Plane Rotation 44
Self Definition 43
Set New CS Visible 44
Toolpath References 44

Current CS, Select 62

Current Display box 139

Current Interface Level 31

Curves, Select 61

Customizing the User Interface 159

Cut Part Rendering 15

Cut Type 55
material 54

Cut Width 36

Cut XY Depth 54

CutDATA 52-53

Cutdata Path 40

Cutter Radius Compensation 35

Cutting Options, Op/Tool Sim 26

D

data collection 33

Date and Time, in post 45

Default Color 23

Delete Row 64

Depth, select by 62

Diagnosing problems in solids 80

Dialogs Follow Application 30

Dialogs Roll-up 30

Dialogs, control over 86
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Index: Digitizer Calibration – Geometry, Show

Digitizer Calibration 35

Dimensions, Select 61

Dimensions, Show 68

Display Lists 21

Display Settings option 16

Do It 71

Don"t Preload Subspindles 154

Drag Rectangle
Appearance Settings 17

Draw Axis 20

Draw Points 68

Drawing
Print 13

Drill Hole 84

Driver Info... 23

Driver, OpenGL Settings 22

Duplicate 74

Duplicate And 74
2d Rotate 74
Force Depth 74
Mirror 74
Scale 74
Translate 74

E

Edges 24

Edges, Select 62

Edit Appearance Settings... 16

Edit Material 54

Edit menu 58

Enable Caption 29

Enable OpenGL Acceleration 17

Enable toolbar transparency 31

Engraving fonts 40

Extend Lines 68

Extended Characters, in post 45

F

Facet Body Opacity 22

Facets 24

Family, Material 53

Favorites, online help 104

Feature Manager
menu item under Features 85

Features menu 84

Feed Status, Toggle 76

File Extension 41

File Extensions 133

File Launch Behavior 39

Finish Bore 36

Finish Profile 36

floating toolbars
transparency 31

Floor Angle Tolerance 32

Force Depth 71

Format Code 45

Format Name, in post 45

Freehand rotation and translation 184

From Tool Edge 36

FromPos 73

Front View 66

G

G-code 36

G-Code Editor Choices, in
Preferences 49

G-Code Editor Preferences 49

G-Code Output 45

GCStatsAdmin.exe 33

Gen 2 Engine 81-82

Geometry Expert 58, 64, 83

Geometry, moving 184

Geometry, Show 68
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Index: Getting Started – mainmenu

Getting Started 99

Gouge Tolerance 28

Gradient Background 20

Grid Brightness 24

H

Halo Thickness (Color Appearance
Settings) 19

Halo Transparency (Color Appearance
Settings) 19

Hardness 54

Hardware OpenGL 22

Help Button 99

Help menu 98

high degree spline curves 25

History 83

Holder Class Menu Items 38

Hole Data 38

Hole Manager
menu item under Features 84

HoleWizard 38
menu item under Features 84

Home View 66

I

IDs 101

Ignore LatheMax FeedMoves 38

Ignore LatheMaximum Feedrate
Moves 38

Import 12

Import Material 55

Inches to mm 73

Index, online help 103

Insert Comments, Posting 134

Insert Row 63

Interface
Level 2 24
Preferences 31

interopmoves
Clearance Volume 189

interpolation
using Clearance Volume 190

Invert Selection 60

IPR 55

Isometric View 66

J

Java Runtime Environment 105

L

Labels 62, 68, 75

Launch New Application on File 39

Length in Characters, in post 46

Length in Feet, in post 46

Length in Meters, in post 46

Level 1 Interface 31

Level 2 Interface 31

License Options 34

Lights Appearance Setting 18

Line segments 77

Lines drawn for high degree curves 25

Lines, Select 61

M

Machine Definition Document (MDD)
defined 12

Machine Sim
preferences for Display settings 16

Machine Sim Path 40

Machine Space
Clearance Volume 190

Machining Face Check 81

Machining Preferences 35

Macros menu 95

main menu
Edit 58
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Index: Managers – Options button

Features 84
Macros 95
Modify 71
Plug-Ins 94
Solids 80
View 65
WEDM (Wire EDM) 95

Managers
accessing 88
customizing headers 92
data types 88
editing data 90
right-click context menus 91

Material
Alloy Group 54
changing 54
importing 55

Material Database 52

Material List 54

Material Properties 18-19
Color (Appearance Settings) 18

Material, part 51

Material.txt and CutDATA.txt 40

Materials
Cut Type 54

Materials Database file 40

Maximum Feedrate
ignoring in Lathe 38

MDD
defined 12

MDD Path 40

Minimize, Posting 134

Mirror 71

MM to inches 73

MMPR 55

Modify menu 71

Mouse Drag, Select 60

Mouse Position 67

Move Part Origin 79

MTM
posting 133

Multi-Level Sort 91

Multi-Pass Stitch 81

N

Name, select by 63

NC program 93

Network Licensing Option 34

New Part Interface Level 31

Next Operation
Render 139

Non-Cutting simulation 145

Number of Parts, in post 45

NURBS 77, 81

O

Offset 36

On Item, help 99

Online Help 98

OpColor Mode 145

OpManager
accessing 88
customizing headers 92
data types 88
editing data 90
right-click context menus 91

Op Sim
Cutting Options 26
Display Options 23
Lighting 18
Performance 26
preferences for Display settings 16

Op Sim display
Transparency 20

Open Part Interface Preference 31

OpenGL 21

Operation Comment, in post 45

Operation Manager
accessing 88
customizing headers 92
data types 88
editing data 90
right-click context menus 91

Operation Number and Type, in post 45

Optional Stops, Posting 134

Options button 16
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Index: P-Buffer OpenGL – Save Size

P

P-Buffer Open GL 22

Palettes, lock 31

Panning the Part 126

Part Space
Clearance Volume 190

Partial Updates 21

Paths
for VMMs, MDDs, and Machine Sim 40

Performance, Op/Tool Sim 26

Performance, Rendering 21

Plane Opacity 18

Play (CPR) 139

Play button 139

Plug-Ins Guide 95

Plug-Ins menu 94

Pocketing, Offset 36

Points, Select 61

Pop-up axis block 184
(illustrated) 184

Post
Selection 133

Post File Overwrite 39

Post Processing Comments 44

Post Processor button 131

Post Processor dialog 131

Posted Output 45

posting
MTM considerations 133

Pre-selection Properties 19

Preferences 14, 155

Previous View 66

Prim 1 146

Prim 2 146

Print
Black on White 24
GE to Text File 83
Post 13
Screen 24

Printing 156

Printing Preferences 24

Process Manager 87
accessing 88
customizing headers 92
data types 88
editing data 90
right-click context menus 91

Program Comment, in post 45

Program Name, in post 45

Program Number 134

pseudoholder display 25

R

Radial 78

Rapid Geometry 76

Rebuild Solid 80

Recent Files 13

Record Video
button in Simulation palette 140

Redraw 66

Reload Simulation 154

Remove Unneeded Topology 81

Render 152
Play 139

Rendering colors 145

Rendering Options 21

Reverse All Rows 64

Reverse Arc 71, 76

Reverse pattern, sort 76

Rotating the Part 126

Rotation
freehand 184

Rough Bore 36

S

S pattern sort 75

Save
A Copy 11

Save Size 39
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Index: Scale – Targeting pixel tolerance

Scale 73

scrollwheel 125-126

Search, online help 104

Segment Spline 77

Select
Circles by Full Diameter Range 60
Circles by Full Radius 60
Lines, All 61
Lines, Feeds 61
Lines, Rapids 61
Mouse Drag 60

Select machine assembly 150

Selected Op to
Lightwork File 83
Screen Points 82
Splines 83
Text File 83

Selected Ops, Posting 133

Self-Intersect Loops 80

Semi-transparent Drag Rectangle 17

Sequence From, Posting 134

Set Font Directory 40

Set Op Start/Stop #s 152

SFPM 55

Sheet Side, Toggle 78

Sheets, Select 61

Shininess 19

Shininess, Material Properties 19

Show
Stock & Origin 68

Show Clearance Volume
Customization 190

Show Op 152

Show Time 152

Shrink Wrap 79

Shrink Wrap Visible 79

Shrinkage 77

Side View 66

Sim
Display Options 23

Sim tab 19

Simplify 81

Skip Pecks 153

Skip unselected Op 148

Slider 27

SMPM 55

Soft Shadows 22

Software OpenGL 22

Solid Edges (Color Appearance
Settings) 19

Solids menu 80

Sort, points and circles 75

Special Functions, in post 45

Specular 18

Specular, Material Properties 18

Speed Control slider 139

Splines 77

Start At Op 152

Start Maximized 29

Starting Program Number, Posting 134

Starting Tool State, in post 45

Statistics for Op/Tool Sim 28

statistics on usage 33

Step Forward (CPR) 139

Steps Per Update 21

Stitch Utilities 81

STL 153

Stop (CPR) 139, 144

Stop Before Load/Unload 152

Stop Before Op 152

Sub Number, in post 46

Suggest 57

System, Appearance Settings 21

T

Tablet 35

Tap Table 38

Tapered Tools 36

Targeting pixel tolerance 31
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Index: Test FrameRate – Wire Drawing

Test Frame Rate 23

Text, Select 61

Tick Delay 101

ToggleWall/Air 76

Tolerance, of collision settings 28

Tool
Material 55
Size, relating to material 54

Tool Center 35-36

Tool Comment, in post 45

Tool Edge 36

Tool Manager
accessing 88
customizing headers 92
data types 88
editing data 90
right-click context menus 91

Tool Motion on Target Body 145

Tool Number and Type, in post 45

Tool Sim
Cutting Options 26
Display Options 23
Lighting 18
Performance 26
preferences for Display settings 16

Tool Sim display
Transparency 20

toolbars
transparency 31

Toolpath Display 35

Tools sub-menu 80

Tooltips 100

Top View 66

ToPos 73

Trace From Run 149

Trace Operation 149

Trackball
Customizing 159

Translate 74

Translation
freehand 184

Transparency, Material 20

Transparent Dialogs 30

turning toolholders
previewing 25

U

Unwrap Geometry 78

Unzoom 66

Unzoom on View Change 17

Updates
one-time check 101

usage statistics 33

UseOp Start 152

UseOp Stop 152

utilities
GCStatsAdmin.exe 33

V

Vertex Arrays 21

Video, outputting 140

View Animation Speed 18

View menu 65

VisibleWGs 71

VMM Path 40

W

Wall Angle Tolerance 32

Wall geometry 76

Walls From Selected Edges, Select 62

WEDMmenu 95

WGManager
accessing 88
customizing headers 92
data types 88
editing data 90
right-click context menus 91

Willemin 508MT
and Clearance Volume 189

Window Size 29

Window Snap Positioning 30

Wire Drawing 24
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Index: Wire EDMmenu – Zooming the part

Wire EDMmenu 95

Wire Frame 24

Workgroup Comment, in post 45

WorkgroupManager
accessing 88
customizing headers 92
data types 88
editing data 90
right-click context menus 91

WrapGeometry 78

Z

Zoom 67

Zooming the part 126
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